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Getting started

1 Getting started

1.1 Introduction

Easy Data Transform allows you to quickly transform table and list data into new and more
useful forms, without programming. The step-by-step visual transformation is quicker, more
interactive, more repeatable and less error prone than other approaches.

Please take a couple of minutes to read the Quick Start Guide.

1.2 System requirements
The suggested requirements for running this software are:

e Operating system: Windows 7, 8 or 10 (64 bit versions only).
e Screen resolution: 1280x720 pixels or better.

If your operating system is more recent than the above, check our website to find a
compatible version of Easy Data Transform.

You may be able to run the software satisfactorily on lower specification systems or more
operating systems, but we can't guarantee it. If in doubt, try running an unlicensed trial
version before you buy a license.

1.3  Quick start guide

This is a quick tour of some of Easy Data Transform's features. It should only take a few
minutes to complete.

Start Easy Data Transform. If the Free Trial window appears, click Continue free trial. If the

Getting Started window appears, click I got this! (or you will just end up back on this page).
You should now see the main window.

Easy Data Transform © 2021 Oryx Digital Ltd



Getting started

& Easy Data Transform v1,15.0 (licensed to Oryx Digital Ltd)* - o X
Eile Edit View Licensing Help

ODBBE v AR H @  rHowDol?
o Input

From File @

From Clipboard ()

EEmail us questions/feedback

Drag a data file you want to transform onto Easy Data Transform. For example a .csv file or
an Excel .xIsx/.xls file. XML, JSON, fixed width and vCard formats are also supported.
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€

DB8E v A QF @  *HowDoR

¥  Input = vaccination.csv @ o ?i E
From File (@ File: ndy\Desktop\vaccination.csv ...
From Clipboard (%) Type: Delimited text o
~ Transform Delimiter: Automatic -
All transforms = Quoting:  Automatic s
Case @ Encoding: Automatic =
Chop @ Ignore:  First 0 row(s) =
Clone @ v has header
Compare Cels (3) v trim whitespace
Concat Cols () v simplify whitespace
Concat Rows. 1) v ignore emply rows
CopyCols (@ watch file
Count @) Meta info: Mot added -
Cross @ Alias: vaccination
Date Format () Data  Warnings  Info  Com 4 ¥
Decode (@ 3 cols x 5,780 rows
Dedupe @) C B F © showfisti0rows -
= ® country time bcg vacc
. ® 1 afg 1982 10
Filter & 2 afg 1983 10
Gather @ 3 afg 1984 M
Header () 4 afg 1985 17
if G 5 afg 1986 18

EEmail us questions/feedback

Notice that the available transforms are shown in the Left pane and the selected dataset is
shown in the Right pane.

In the Right pane, you can check has header, depending on whether you want to treat the
first row of the dataset as a header.
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vaccination.csv @ E i
File: ndy\Desktop\vaccination.csv ... |
Type: Delimited text v
Delimiter: Automatic v
Quoting: Automatic v
Encoding: Automatic v
Ignore:  First O row(s) .

v has header |
rim whitespace
v simplify whitespace i
v ignore empty rows
watch file
Meta info: Not added v
Alias: vaccination

Data = Warnings Info Conm 4|}

3 cols x 5,780 rows
C E% f © Show first 10 rows ¥

Guntry time bcg_vacD

All the transforms available for a single dataset are now enabled in the Left pane. Hover
over the transforms to see tooltips explaining what they do. Click on the ? next to a
transform button for more details.

Ensure the input item is selected and click on the Case transform button to change the case
of your data.
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E Easy Data Transform v1.15.0 (licensed to Oryx Digital Ltd)* - o X
Eile Edit View Licensing Help
DERE v AR E @  rHowDol?

¥  Input = vaccination.csv @ o éi E
From File (@ File: ndy\Desktop\vaccination.csv ...
From Clipboard (%) Type: Delimited text o
~ Transform Delimiter: Automatic -
All transFornlE i Quoting:  Automatic >
Case Encoding: Automatic =
Chop @ Ignore:  First 0 row(s) =
Clone @ v has header
Compare Cels (3) v trim whitespace
Concat Cols () v simplify whitespace
Concat Rows (%) v ignore emply rows
CopyCols @ vaccination.csv watch file
Count @ 2 eols 5.6 rows Meta info: Mot added -
e ® Alias: vaccination
Date Format () Data Warnings Info Com 4 F
Decade ® 3 cols x 5,780 rows
Dedupe @) C B F © showfisti0rows -
= ® country time bog_vacc
. ® 1 afg 1982 10
Filter ® 2 afg 1983 10
Gather (@ 3 afg 1984 11
Header () 4 afg 1985 17
if @ 5 afg 1986 18 .

EEmail us questions/feedback

A Case transform item will now be added.

Easy Data Transform © 2021 Oryx Digital Ltd




Getting started

E Easy Data Transform v1.15.0 (licensed to Oryx Digital Ltd)* - o X
Eile Edit View Licensing Help
DERE v AR E @  rHowDol?

¥ Input E Case @] - =
From File @ B & Filter column 1
From Clipboard (%) [ cou ntry
time

~ Transform
beg_vacc

All transforms =

0 of 3 columns selected

Case @
Chop @ Change case to: Lower case =
Clone @ (Change the case in the selected calumnis).
Is G
Compare Cels (3 Data  Wamings Info  Com ¢ P
=
Concat Cols @ 3 cols x 5,780 rows
Concat Rows (2 [ & @ showfisti0rows ~
CopyCols (@ Jvaccmat'on'ﬁv Y Case country time |bcg_vacc
Count @ 3 cols x 5.8k rows 3 cols x 5.8k rows 1 afg 1982 10
ross (7
Cross @ 2 afg 1983 10
Date Format (2
ate Forma \_) 3 afg 1984 11
Decode @
s 4 af 1985 17
Dedupe (3@ 9
Extract @ 5 afg 1986 18
Fill @ 6 afg 1987 27
Filter @ 7 afg 1988 40
h @
Sather ‘) 8 afg 1989 18
Header (2

9 afg 1990 20

3

If

a

1N afn 1991 21
EEmail us questions/feedback

In the Right pane, check one of the columns and set Change case to to Upper case. All the
text in that column will now be converted to upper case. You don't have to click a 'run’
button.
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KA
Case ® KN
E Q Filter columns
{ v country

ime
bcg_vacc

1 of 3 columns sele

Change case td; Upper case

Change the case in the selected column(s).

Data  Warnings Info  Com ¢ *

3 cols x 5,780 rows
EE."_;; E% f © Show first 10rows ~

ountry time beg vacc

1 1982 10

2 1983 10

You can create a sequence of transforms to perform complex manipulations.

Jvaccination,cw Y Case v Filter y Sort

3 wls x 5.8k ows 3 cols x 5.8krows 3 cols x4.5krows 3 cols x 4.5k rows

Some transforms require more than one input dataset. For example, to stack two datasets,

one on top of the other:

e Select File>New to start again. Don't save the changes.

¢ Drag two data files onto the Center pane.

e Select both input items (by dragging a box around them or using ctr1+click).

e Click the Stack transform button (you may need to scroll the Left pane to see the
button).
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E Easy Data Transform v1.15.0 (licensed to Oryx Digital Ltd)* - o X
Eile Edit View Licensing Help
DERE v AR E @  rHowDol?

= Py R A -
Insert G vaccination.csv @ ‘o i
Interpolate File: ndy\Desktop\waccination.csv ...
e Type: Delimited text b
N Delimiter: Automatic -
_ Quoting:  Automatic o
Join
Encoding: Automatic -
Laokup —
) Ignore: First 0 row(s) -
NEW LD - .
vaccination.csv W has header
MU C i
— 3 ools x 5.5k rows v trim whitespace
rad . . .
: v simplify whitespace
Al v ignore emply rows
Remave Cols watch file
R € Co Meta info: Mot added =
Rearder C Alias: vaccination
Replace

Data  Warnings  Info  Com 4 ¥

accination2.csv 3 cols x 5,780 rows

C B F © showfisti0rows -
country time bcg vacc

1 afg 1982 10

3 ools x 4.5k rows

2 afg 1983 10

3 afg 1984 M

—_— 4 alg 1985 17
(_ Stack @
f 1986 18
Stamp @~ 5 afg =

EEmail us questions/feedback

The tables are now stacked one on top of the other in a new dataset item. You can choose
to match the columns by Header name or Column number.
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E Easy Data Transform v1.15.0 (licensed to Oryx Digital Ltd)* - o X
Eile Edit View Licensing Help
DERE v AR E @  rHowDol?

Insert @ = Stack | @ (:P ?c
@ Align calumns tjé. Header name ) b
Merge inp ta pof another.
@ |'Drde e vertical positions of the input
Javaseript (3 daglEts
T @ / Data  Wamings Info  Comm 4 *
Lo @ 3 cols x 10,258 rows
Heweo I8 vaccination.csv LB/ @ D R0 O e
Num Format (&) country time bog vace
Pad @ 3 mls x 5.8k rows 1 ﬂfg 1982 10
Pivot @ 2 afg 1983 10
Remaove Cals (&) Stack 3 afg 1984 11
Rename Cols (&) 4 ok 4 lafg 1985 17
Reorder Cols (3 5 alg 1986 18
Regiace (@ 6 afg 1987 27
Row Num (@ vaccination2.csv
sample @ e s 7 afg 1988 40
Slice @ g afg 1989 28
Sort @ 9 afg 1980 20
splitcol (@ 10 afg 1991 21
Split Rows (&
Spread @ Last 10,248 rows not shown
Stack &)
Stamp @~

EEmail us questions/feedback

Note that the vertical (Y) position of the inputs affects the order the datasets are stacked.
Try swapping the two inputs around and re-select Stack to see the affect.

Any changes to input files will be automatically read in. Any changes to input datasets or
transform options will be automatically propagated 'downstream’.

To export your transformed dataset to a file or the clipboard, view it in a local editor or see it
with whitespace displayed, click on the appropriate button in the Right pane.
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Stack @ E Z

Align columns by: Header name v

Merge input datasets one on top of another.
Orders by the vertical positions of the input
datasets.

Data = Warnings Info Comm * »

Show first 10 rows ~

You can also add an output item to automatically write a dataset to file whenever it
changes.

& Easy Data Transform v1.15.0 (licensed to Oryx Digital Ltd)* - ] *
File Edit View Licensing Help
DERE v QAR FH @  rHowDol?

r wA
Rename Cols (&) Stack (@) = o
Reorder Cols (%) Align columns by: Header name ¥
= Merge input datasets one on top of another.
Repl [/ .
pEcs, O rders by the vertical positions of the input
Row Mum (@ datasets
Sample (@ Data  Wamings Info  Comm ¥ *
slice & 3 cols x 10,258 rows
sot @ BE S @  showficti0rows ~
vaccination.csv -
splitCol @ country time |beg_vacc
Split Rows (@) 3 oole x 5.8k rows 1 afg 1382 10
Spread (@ 2 afg 1983 10
Stack @ Stack 3 afg 1984 M
Stamp @ 4
swots © 3 cols x 10.3k rows ol =) LR
= 5 afg 1986 18
Substitute (%)
- 6 afg 1987 27
@ vaccination2.csv
Summary (3 7 afg 1988 40
3ok x 4.5k rows
Total @ 8 afg 1989 38
Transpose (%) 9 afg 1990 30
Unique @
i ol 10afg 1991 21
Units &
Whitespace (& Last 10,248 rows not shown
»  Qutput

(: Ter File :@,

=1Email us questicns/feedback

You will be asked for a file to write to. You can choose amongst CSV, Excel, HTML, JSON,
Markdown, TSV, vCard, XML and YAML file formats. Select CSV file.
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File name: | output.csv

Save as type: |(CSV file (*.csv)

Excel file (*

Your dataset will then be written to this file every time it changes.

& Easy Data Transform v1,15.0 (licensed to Oryx Digital Ltd)* - O X
Eille Edit View Licensing Help

ODB8E v« A Q3 @  *HowDon

= output.csv @ ?C E
File: wndyhDesktophoutput.csy ..
Type: Delimited text b
Delimiter: Comma () *
Quoting: As needed v
Line endings: Automatic ¥
Encoding:  UTF-8 ¥
N ' Byte Order Mark

Split Col vaccination.csv . .
Write mode: Owerwrite -

plit Row 3 cols x 5.8K rows .
Alias: output

Sp

Data  Wamings Info  Conm 1 *
3 cols x 10,258 rows
C L% f &> Show first 10 rows ¥

country time bcg_vacc

9 Stack

3 cols x 10.3k rows

output.csv
3 cols x 10,3 rows

1 afg 1982 10
J\raccinalionz_csv

2 afg 1383 10

3 cols x 4.5% rows

3 afg 1984 1

4 afg 1985 17

5 afg 1986 18

6 afg 1987 27

7 afg 1988 40

g afg 1989 38

.,
@
a
L

EEmail us questions/feedback

You can also specify the Delimiter, Quoting, Encoding, Line endings etc for your CSV files
in the Right pane.
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output.csv @ Eﬂ
File: \andy\Desktop\output.csv ...
Type: Delimited text v
Delimiter: Comma (,) v
Quoting: As needed v
Line endings: Automatic v
Encoding:  UTF-8 v

v Byte Order Mark

Write mode: Overwrite v
Alias: output

You can save your transforms to a transform template document to use again with
File>Save.

Have a play!

Tips:

e You can also paste in data from the clipboard (for example, a table from a web page or
Word document).

e The Compare Cols, Filter, If and Sort transforms take account of dates, numbers and
text. You can define what date formats to recognize in the Preferences window.

e New columns are always added to the right of a dataset.

e Comparisons of text are always sensitive to case, unless stated otherwise. E.g. "CASE",
"case" and "Case" are treated differently.

e Comparisons of text are always sensitive to whitespace (e.g. spaces and tabs), unless
stated otherwise. You can use the Whitespace transform to remove leading and trailing
whitespace.

e The contents of input and output data files are not saved in Easy Data Transform, only
their locations.

e As well as stacking two datasets, you can also Join them, side-by-side, if they have a
common (‘key") column.

¢ You can insert a new transform between existing items by selecting the connection
between the items and then adding the transform.

e To be more productive with Easy Data Transform see expert tips.
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We are interested in your feedback, so please contact us to ask a question, report a bug or
request an enhancement.
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Reference

2.1
2.11

2.1.2

Easy Data Transform

Reference

User Interface
Main window

The Main window comprises:
¢ Main menu
e Tool bar

o Left pane
o Center pane

¢ Right pane
e Status bar

Main menu
Tool bar Left pane Center pane Right pane
Easy Data Thnsform v1.15.0 (jg#hsed to Oryx Digital Lty - 0O X
File Edit Vi Licensing
DBEER&A v Q@ S 3 ®  HowDol?
R s (3 = output.csv @ :: =
@ File; sandy\\Desktop\output.csv | ...
snlace 0, Type: Delimited text b
= Delimiter:  Comma () i
Ry
@ CQuoting As needed -
= . Line endings: Automatic o
Q) e ca
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Status bar Input Transform Output

You can split the Right pane onto a separate monitor (if available) by selecting View>Two
Screen Mode.

Left pane

The Left pane shows all the available actions you can perform. Which actions are visible will
depend on what is shown in the Center pane. Which actions are enabled depends on what

© 2021 Oryx Digital Ltd




Reference

is selected in the Center pane.
2.13 Center pane

The Center pane show the inputs, transforms and outputs you are using to transform your
data.

2.1.4  Right pane
The Right pane shows details of an input, transform or output item you have selected in the

Center pane.

2.1.5 Preferences window

General tab

Check give option to disable outputs when opening a file if you want the option to
disable any ouputs with write mode overwrite or append when you open a file, preventing
accidentally writing over existing files. Note that this check is never made when using the -
exit command line argument.

Check use native file windows to use the native Windows file open/save windows.

Check make a sound when processing completed if you want to make a system sound
every time processing is completed.

Set At start-up depending on what you want to happen when Easy Data Transform starts.

Set User interface theme to Automatic follow the theme of the operating system or
override it by setting Light or Dark. This is only available if your operating system supports
a dark theme. Changing User interface theme does not update the Center pane colors. You
can also toggle between themes using a keyboard shortcut.

Set Tool bar icon size to the size of the icons you wish to display in the tool bar.

Set Right pane processing delay depending on how long you want to wait after changes in
the Right pane before starting processing. Setting the value to 0 is generally not
recommended, as this means that every single click in the Right pane will cause processing.

Set Zoom wheel behavior according to how you want the mouse wheel to work in the
Center pane. Hold down the ctr1 key while moving the mouse wheel to switch between
zoom and scroll. Hold down the a1t key while moving the mouse wheel to switch between
up/down and left/right scroll.
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User interface font shows the font used for the application user interface, apart from data
tables (see below). Click Choose... to choose a new font. Click Default to set it back to the
operating system default.

Data table font shows the font used in the data tables in the Right pane. Click Choose... to
choose a new font. You might prefer a monospaced (fixed width) font such as Consolas,
Lucida Console or Courier New. Click Default to set it back to the operating system default.

The Locale language and country setting affects how some numbers and dates are
displayed. Consequently it may an affect on some transforms. It does not change the
language of the user interface, which is English only.

Set Supported date formats to the date formats you wish to recognize. List the date
formats in order of preference, with the most likely to be used first.

Input Extensions tab
Set the default file types corresponding to input file extensions.

Click in the Extension column and type to change an input file extension. The text will be
trimmed of whitespace, converted to lower case and any ".' characters removed.

Click in the Default type column and change the drop-down list to change the file type to
associate with an input file extension.

Click Add to add a new input file extension.
Click Remove to remove the selected input file extension(s).
Click Default to set the input file extensions back to the default setting.

The order in which input file extensions are shown is not significant.
Output Extensions tab

Set the default file types corresponding to output file extensions.

Click in the Extension column and type to change an output extension. The text will be
trimmed of whitespace, converted to lower case and any ".' characters removed.
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Click in the Default type column and change the drop-down list to change the file type to
associate with an output file extension.

Click Add to add a new output file extension.
Click Remove to remove the selected output file extension(s).
Click Default to set the output file extensions back to the default setting.

The order in which output file extensions are shown is not significant.

Colors tab

Select a Color scheme for the Center pane. A Preview is shown below. Choose Custom to
choose your own color scheme.

2.2 Input
2.2.1 Inputdata

You need to input data before you can transform it. Data can be input by:
e dragging a file onto the Center pane; or
e clicking the From File or From Clipboard button in the Left pane

Enter the file location in File or click the browse button. For Excel spreadsheets you also
need to add a sheet name, e.g. 'MySpreadsheet.xIsx[Sheet1]".

Easy Data Transform can input data from files in the following formats:
e delimited text file (e.g. CSV or TSV) with various delimiters

e Excel .xlsx or xls

e fixed width

e Plain text

* JSON

e vCard

e XML

You can select the input item in the Center pane and change any related options in the
Right pane.
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vaccination.csv @ E C
File: ndy\Desktop\vaccination.csv ...
Type: Delimited text v
Delimiter: Automatic v
Quoting: Automatic v
Encoding: Automatic v
Ignore: First O row(s) -

v has header
v trim whitespace
v simplify whitespace
v ignore empty rows
watch file
Meta info: Not added v
Alias: vaccination

Data  Warnings Info  Com ¢ ?

3 cols x 5,780 rows
C |;g{l} f © Showfirst 10rows ~

country time bcg_vacc

Set Type to the file type. The default type will be set according to the file extension and the
settings in the Input Extensions tab of the Preferences window.

For text files Easy Data Transform will treat crLF, LF or cr control characters as line endings.

Easy Data Transform will make an intelligent guess at the:

e column delimiter and quoting for delimited text files (e.g. comma)
e column widths for fixed width text files

¢ text encoding for text files (e.g. UTF-8)

e presence of a header row in the data
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But you can also do this manually by selecting the input item and changing the Delimiter,
Columns, Encoding and has header fields in the Right pane.

Data will normally be read from the first non-blank line. Set Ignore if you want to ignore a
number of rows before you start inputting. Note that empty rows are counted.

Set Format to Long (more rows) or Wide (more columns) depending on how you want
to treat arrays/repeat values in JSON or XML.

Check trim whitespace to trim any whitespace (e.g. tabs or spaces) off the start or end of
data values.

Check simplify whitespace to replace any tabs or line feeds within data values with spaces
and remove carriage returns.

Check Ignore empty rows to remove any rows that have only empty values (whitespace is
not considered empty).

Check watch file if you want the file to be automatically reloaded every time that Easy Data
Transform detects that it has been changed (which will then update everything
‘downstream’).

Use Meta info if you wish to add some meta information about the input dataset, e.g. the
name of an input file or the date it was created.

Use Alias to identify the file for batch processing.

Use Comment to record any notes that might be useful to a colleague or your future self.
To change the file being used by an input, select the input item and change the file location
in the Right pane (e,g, by clicking the "..." browse file button), rather the disconnecting the

input and connecting a new one. Otherwise column-related parameters downstream will be
reset.
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2.3 Transforms
2.3.1 Transform data

Transforms operate on datasets from input data or other transforms. Some transforms only
have a single input (e.g. Case), some transforms have two inputs (e.g. Join) and some
transforms have two or more inputs (e.g. Stack).

To create a transform, select one or more input and/or transform items in the Center pane
and then click the appropriate button in the Left pane.

Select from the drop-down list in the Left pane to choose which types of transform are
displayed, e.g. select Merge Transforms to show only transforms related to blending data.

You can select the transform item in the Center pane and change any options related to the
transform (e.g. which columns it acts on) in the Right pane.

The transform will be updated automatically if any input or transform 'upstream’ of it
changes.

Use Comment to record any notes that might be useful to a colleague or your future self.
23.2  Calculate
Description

Performs a calculation on 1 or 2 columns and creates a new column.

Examples
Rounding a column of numbers to the nearest integer:
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date elo1

1 1920-09-26 1503.947
2 1920-10-03 1503.42

3 1920-10-03 1503.42

|

Calculate @ CP =2 E§|
Column 1: elo1 v |
Operation: Round v |

date elol Round(elo1)

1 1920-09-26 1503.947 1504
2 1920-10-03 1503.42 1503

3 1920-10-03 1503.42 1503

Multiplying 2 columns of numeric values:
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ItemID Quantity Cost
1 HG89397834 1 99.00
2 LK02384030 4 9.95
i
i 3 HG99200444 2 7.95
Calculate @ t[f} @ Eg
Column 1: Quantity v
Operation: * Multiply v
Column 2: Cost v
ItemID Quantity Cost Quantity*Cost
1 HGB9397834 1 99.00 99
2 LK02384030 4 9.95 398
3 HG99200444 2 795 159

Adding a days column to a date column:
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Start Duration
1 31/12/2019 7

2 01/01/2021 14

3 07/01/2021 1

Calculate @ dﬁ @ Eg
Column 1: Start v
Operation: + Add v
Column 2: Duration v

Start Duration Start+Duration
1 31/12/2019 7 /172020
2 01/01/2021 14 15/1/2021
3 07/01/2021 1 8/1/2021

Calculating the difference in days between 2 date columns:
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Start End
131/12/2019 7/1/2020

2 01/01/2021 15/1/2021

3 07/01/2021 8/1/2021

}

Calculate @ Qu @ EQ
Column 1: End v )
Operation: - Subtract v
Column 2: Start v

Start End End-Start

131/12/2019 7/1/2020 7
2 01/01/2021 15/1/2021 14

3 07/01/2021 8/1/2021 1

Inputs
One.

Options

e Set Column 1 to the first column you wish to operate on.

e Set Operation to the operation you wish to perform.

¢ Set Column 2 the second column you wish to operate on (binary operations only)

Notes
¢ The following operations are supported.
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Operation

+ Add

- Subtract

* Multiply
/ Divide

A Power

%
Modulus

Abs

Ceiling

DayOfWee
k

DayOfMo
nth

DayOfYear
Decremen

t

Floor

Column Column
1 2
Number Number
Date Integer
number
Number Number
Date Integer
number
ate Date
Number Number
Number Number
Number Number
Integer Integer
number number
Number N/A
Number N/A
Date N/A
Date N/A
Date N/A
Number N/A
Date N/A
Number N/A

Easy e -

Notes

Numerical addition

Adds days to the date

Numerical subtraction

Subtracts days from the
date

Days the date in Column
1 is after the date in
Column 2 (negative if
before)

Numerical multiplication
Numerical division

Column 1 to the power
Column 2 (col1«R)

Remainder after Column
1 is divided by Column 2

The absolute value

The smallest integer that
is not less than the value

Day of the week, where 1
= Monday and 7 =
Sunday

Day of the month

Day of the year

Subtract 1

Subtract 1 day

The largest integer that is

Examples

1.2 + 3 =4.2

31/01/2021 + 7 = 07/0z
1.2 - 3 =-1.8
31/01/2021 - 7 = 24/01
31/01/2021 - 24/01/20zZ
24/01/2021 - 31/01/20zZ
1.2 * 3 3.6

1.2/ 3 =20.4

1 / 0 = Error

1.2 ~ 3 =1.728

2 ~ =3 =0.125

7% 2 =1

7 % 0 = Error

Abs( 1.2 ) = 1.2

Abs( -1.2 ) = 1.2
Ceiling( 1 ) =1
Ceiling( 1.2 ) = 2
Ceiling( -1.2 ) = -1
DayOfWeek ( 31/01/2021
DayOfWeek ( 01/02/2021
DayOfMonth ( 31/01/2021
DayOfMonth( 01/02/2021
DayOfYear ( 01/02/2021
DayOfYear( 31/12/2021
Decrement ( 1 ) = 0
Decrement ( -1 ) = =2
Decrement ( 1.2 ) = 0.z
Decrement ( 31/01/2021

Floor( 1 ) =1
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e Whether values are interpreted as number, dates or text depends on Supported date
formats and Locale in the Preferences window.

e To concatenate text in different columns use the Concat Cols transform.

To compare 2 columns use the Compare Cols transform.

For logical operations use the |f transform.

For operations on rows or columns use the Stats transform.

For more complex number/date calculations use the JavaScript transform.

To modify the numerical precision of the results use the Num Format transform.

e To add a new column of values use the New Col transform.

2.3.3 Case

Description
Changes the case of text in one or more columns.

Inputs
One.

Options

e Check the column(s) you wish to transform.

e Set Change case to to Lower case (e.g. "text"), Upper case (e.g. "TEXT") or Title case (e.g.
"Text").

See also
e Whitespace
234 Chop

Description
Remove characters from the start or end in one or more columns.

Inputs
One.

Options

e Check the column(s) you wish to transform.

¢ Set Length to the number of characters you want to remove.

¢ Set From to Start or End depending on whether you want to remove characters from the
start or end.
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Notes

e Whitespace is counted when calculating length. You can use Whitespace to remove
whitespace before chopping.

e If you want to set a column to a fixed length use Pad and Chop together.

See also
e Extract
235 Clone

Description
Makes an exact copy of the input dataset.

Inputs
One.

Options

e None.

Notes
e Clone can be useful to simplify complicated layouts.

2.3.6  Compare Cols

Description
Creates a new column with a comparison of two other columns.

Inputs
One.

Options

e Select the two columns you wish to compare as Column 1 and Column 2 and the
Comparison operator.

e Check case sensitive to use case sensitive matching for text.

Notes

e Number, date and text values are treated differently. Any values that can be converted to
a number will be treated as a number. Any values that match the supported date formats
in Preferences will be treated as a date. All other values are treated as text.

e Comparisons of text are whitespace sensitive. You can use Whitespace to remove
whitespace before filtering and Replace to get of other unwanted characters (e.g.
whitespace inside the text).
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e The new column is added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.

See also

e Split Cols
2.3.7 Concat Cols

Description
Creates a new column by concatenating text from one or more existing columns.

Inputs
One.

Options
e Check the columns you wish to concatenate.
e Supply the Delimiter you wish to place between concatenated text (optional). For

example ",".
e Check keep empty if you wish to keep the delimiter for empty columns.

Notes

e If there is a header, the header of the new column is formed from the header of the
concatenated columns. You can use Rename Cols to change the new column name.

e Concatenating a single column makes a copy of the column.

e The values in the column are in the order of the columns. You can change the column
order before concatenation with Reorder Cols.

e The new column is added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.

e The opposite of Concat Cols is Split Col.

See also
e Concat Rows
e Substitute

2.3.8 Concat Rows

Description
Concatenate multiple consecutive rows into a single row.

Examples
Concatenating this dataset:
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sensor datetime value

1 sensorl 1/1/18 0:00 578

3 sensor1 1/1/18 0:10 541

4 sensor2 1/1/18 0:10 702

Every 2 rows:

|
Concat Rows @ E C

Create 1 row from every: 2

Gives:
sensor datetime value sensor datetime wvalue
1 sensor1 1/1/18 0:00 578 sensor2 1/1/18 0:00 764
2 sensor1 1/1/18 0:10 541 sensor2 1/1/18 0:10 702
Inputs
One.
Options

e Set Create 1 row from every to N to concatenate every N rows into 1 row.

Notes

e Use New Col if you need to add additional columns before concatenating rows.

e Use Filter if you need to remove rows before concatenating row.

e Use Rename Cols if you need to change column names after concatenating rows.
e The opposite of Concat Rows is Split Rows.
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See also

e Spread
e Concat Cols

2.3.9 CopyCols

Description
Creates one or more copies of the selected column(s).

Inputs
One.

Options
e Check the columns you wish to copy.
¢ Set Copies to the number of copies you want to make of each checked column.

Notes

e If there is a header, the header of each new column is the original column name. You can
rename columns with Rename Cols.

e The new columns are added at the right end. You can change the column order with
Reorder Cols.

See also
e New Col

2.3.10 Count

Description
Counts the number of occurrences of each item of text in the selected column.

Inputs
One.

Options

e Select the Column whose values you wish to count.

¢ Set Sort by depending on whether you wish to sort alphabetically by the Text in the left
column or numerically by the Count in the right column.

¢ Set Order depending on whether you wish to sort Ascending or Descending.

Notes
e Date and number values are treated as text.
e You can use Rename Cols to change the new column name.
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See also

e Unique

e Total

e Pivot

tat
e Summary

2.3.11 Cross

[ ]
%]
[%]

Description

Creates an output from combining every possible row combination of each input. E.g. if the
first input has N1 rows and the second input has N2 rows, then the result will have N1 X N2
rows. Also known as a 'Cartesian product’ or 'cross join'.

Examples
letter
B — . letter number
', Clipboard 1A 1
\ 1 col x 3 rows 2 A 2
3C
3A 3
Cross 48 |
74 8
2 cols x @ rows 5B 2
number 6B g
11 y N\ S )
' Clipboard
22— 8C 2
"-\,\ 1 col x 3 rows
] - 9C 3
Inputs

Two or more.

Options

e The output depends on the vertical (Y-axis) position of the inputs.

Notes
e It can create a very large number of rows!
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See also

2.3.12 Date Format

Description
Changes the date format in one or more columns.

Examples
To change from "31/1/2019" to "01-31-19" set Format from to "d/M/yyyy" and Format to
to "MM-dd-yy".

Inputs
One.

Options

e Check the columns you wish to transform.

e Supply the existing date format in Format from (see below).

e Supply the new date format in Format to (see below).

¢ The following date formats are supported for input and output:

Easy Data Transform © 2021 Oryx Digital Ltd



Reference

Format Meaning

d The day as number without a leading

zero (1to 31)

e The day as number with a leading zero
(01 to 31)

ddd The abbreviated localized day name (e.g.
‘Mon' to 'Sun'). Uses the locale to localize
the name.

grelelel The long localized day name (e.g.

‘Monday' to 'Sunday'). Uses the locale to
localize the name.

M The month as number without a leading
zero (1to 12).

MH The month as number with a leading zero
(01to 12)

MMM The abbreviated localized month name

(e.g. Jan' to 'Dec'). Uses the locale to
localize the name.

elLely! The long localized month name (e.g.
‘January' to 'December’). Uses the locale
to localize the name.

Yy The year as a two digit number (00 to 99).

yyyy The year as a four digit number. If the
year is negative, a minus sign is
prepended in addition.

Notes

e An exact match is expected for the input date. E.g. Format from is yyyy-MM-dd then
2020-12-17 will be converted, but 2020-12-17T14:58 won't. You can extract just the
date part here using Split Col with T as the delimiter.

e Use the correct case for the format (e.g. yyyy-MM-dd, not YYYY-mm-DD).

e The Locale set in the Preferences window is used to decide how the date is represented
(e.g. names of months and days).

¢ You can also use Split Col to split a date into its component parts. For example to split
"31/1/2019" into day, month and year components using the "/" delimiter.
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e If the date to be converted has only two year digits, it is treated as a date between 1900
and 1999. E.g. "31/1/19" is interpreted in d-M-yy format as 31st January 1919.
e Warnings are shown in the Warnings tab for values that don't match Format from.

See also
e Num Format

2.3.13 Decode

Description
Convert to/from base64 encoding, URL encoding, escaped HTML or escaped XML.

Examples

Type Plaintext Encoded

based64 <'Hello World!'> PCAdIZWxsbyBXb3JsZCEnPg==
encoding

URL <'Hello World!'> $3C%27Hello%20World%21%$27%3E
encoding

HTML <'Hello World!'> &1lt; 'Hello World!'&gt;

escaping

XML <'Hello World!'> &lt; &apos;Hello World!&apos; &gt;

escaping

Inputs
One.

Options
e Check the column(s) you wish to transform.
¢ Set Change according to how you want to decode/encode the selected columns.

Notes
e This is disinct from text encoding (e.g. UTF-8 vs UTF-16) which is handled on input and
output.

e Use Copy Cols to copy columns before you transform them.
e Data input from XML files and output to HTML and XML files is unescaped/escaped
automatically.
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2.3.14 Dedupe

Description
Remove duplicate rows.

Examples
If you are cleaning up a mailing list, you might want to dedupe on the 'email’ column, after
converting all the emails to lower case.

Inputs
One.

Options
e Check the column(s) you wish to look for duplicate values in.
e Check case sensitive to use case sensitive matching.

Notes

e Rows are considered duplicates if they have exactly the same value in all the checked
columns.

e Comparisons are whitespace sensitive. You can use Whitespace to remove whitespace
before deduping and Replace to get of other unwanted characters (e.g. whitespace inside
the text).

e When several rows are duplicates, only the top one is retained.

e The Unique transform is a more powerful (but more complex and slower) alternative to
Dedupe.

See also
e Dedupe a dataset

2.3.15 Extract

Description
Extract a length of text in one or more columns.

Inputs
One.

Options

e Check the column(s) you wish to transform.
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¢ Set Length to the length you want values in selected columns shortened to.

e Set From to Start or End depending on whether you want to take from the start or end.

¢ If From is Start then Offset is the offset of the first character from the start (O to start
with the first character). If From is End then Offset is the offset of the last character from
the end (0 to start with the last character).

Notes
e Whitespace is counted when calculating length. You can use Whitespace to remove

whitespace before extracting.
e If you want to set a column to a fixed length use Pad and Extract together.

See also

e Chop
2.3.16 Fill

Description
Fill empty cells in selected columns with the next adjacent non-empty cells. The direction is
the direction to fill to (not from).

Examples
This is useful for filling in gaps in hierarchical tables. For example filling Down the first two
columns of this dataset:

Country 1 Area 1 City 1
City 2

City 3

Area 2 City 1

City 2

Gives:
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Country 1 Area 1 City 1
Country 1 Area 1 City 2
Country 1 Area 1 City 3
Country 1 Area 2 City 1

Country 1 Area 2 City 2

Inputs
One.

Options

e Check the column(s) you wish to fill.

¢ Select Direction depending on the direction you wish to fill to.
2.3.17 Filter

Description
Removes rows based on number, date and text values in selected columns.

Examples
To remove rows where all values are empty.
Filter @ E g
@ ® Remove ¥ | Matching any
Column Op. Value
1 <Any> vij= ¥

To keep only rows where the Tax value is greater than 0 and the Country value is "US".
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|
Filter ©, e
@ @ Keep ¥ Matchingall ~ ,
Column Op. Value |
1 Tax vYi> ¥]0 !
2 County v|= ¥ |US i
Inputs
One.
Options

e Click the '+' button to add a new filter criteria.

e Click the 'x' button to delete the selected filter criteria.

¢ Select Keep if you want to keep matching rows and Remove to remove matching rows.

¢ Select Matching all to match on all criteria (e.g. criteria 1 and criteria 2). Select Matching
any to require a match on one or more criteria (e.g. criteria 1 or criteria 2).

e Set Column to the column you wish to match.

e Set Op. to the comparison operator.

¢ Set Value to the value you wish to compare.

e Check case sensitive to use case sensitive matching for text.

e Check disable filtering to turn off filtering. If sampling is disabled, the transform does
nothing.

Notes

e A filter row is ignored if the Value column is empty , except when Op. is Equal to, Not
equal to, Matches regex or Doesn't match regex.

e Number, date and text values are treated differently for Equal to, Greater than, Less
than, Greater than equal, Less than equal and Not equal to operations. Any values that
can be converted to a number will be treated as a number. Any values that match the
supported date formats in Preferences will be treated as a date.

e All values are treated as text for Contains, Starts with, Ends with, Matches regex, Is not,
Doesn't start with, Doesn’t end with and Doesn't match regex operations.

e Comparisons of text are whitespace sensitive. You can use Whitespace to remove
whitespace before filtering and Replace to get of other unwanted characters (e.g.
whitespace inside the text).

e See here for more details on Regular expressions (regex).

See also
e Slice
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2.3.18 Gather

Description

Gather multiple columns into new key and value columns. Also called unpivot, long pivot or
group by.

Examples

salesman area QIGQ2NG3NG4
1 Alice North 11.3 893 443 18

2 Bob East 45 79 8 2

With columns Q1, Q2, Q3 and Q4 gathered:

KA
Gather N
E Q Filter columns
salesman
area

v Q1

v Q2

v Q3

v Q4

4 of 6 columns selected

Key column name: Quarter

Value column name: Amcunﬂ

Gives:
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salesman area Quarter Amount

1 Alice North Q1 1.3
2 Alice ;
3 Alice E
4 Alice ;
5 Bob 45
6 Bob 79
7 Bob 8
8 Bob 33

Inputs

One.

Options

e Select the Columns you wish to gather.

¢ Set Key column name to the name of the new key column, which will have values based
on the names of the columns selected.

e Set Value column name to the name of the new value column, which will have values
based on the values in the columns selected.

Notes

e New columns are added at the right end. You can change the column order with Reorder
Cols.

e You can merge the value and key columns into a single column with Concat Cols.

e The opposite of Gather is Spread.

See also

e Split Rows
2.3.19 Header

Description
Move rows from the top of the dataset into the header.
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Examples

Sample Sample Sample
11 2 3
222333 93883 923482
39082.43 946.88 620.09

49397 148.64 45520

With 1 row appended to the header:

Header @ tf’ E:i:

Top rows to move: 1

Existing header:  Append v

Delimiter: -

Gives:
Sample-1 Sample-2 Sample-3

122333 938.83 9234.82
2908243 94688 620.09
393.97 148.64  455.20

Inputs

One.

Options

¢ Set Top rows to move to the number of rows you want to move from the top dataset
into the header. Setting it to 0 means the transform does nothing.
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¢ Set Existing header to Overwrite to ignore the existing header values and Append to
add to the existing header values.

o Set Delimiter to any text you want to put between column elements. It can be left empty.
Ignored if Existing header set to Overwrite and Top rows to move set to 1.

Notes

e Empty cells are ignored.

e You can Sort and Filter your dataset to change the top rows.

e You can add the header from one dataset to another dataset using Stack.

See also
e Headers
2.3.20 |If

Description
Sets the value of a new column based conditionally on values in one or more other columns.

Inputs
One.

Options

e Click the "+IF' button to add a new IF/ELSE IF.THEN condition.

e Click the '+AND' button to add an AND to the selected IF/ELSE IF..THEN.
e Click the 'x' button to delete the selected IF/ELSE IF.THEN/AND.

e The Logic column shows the type of row.

e Set Column to the column you wish to match.

e Set Op. to the comparison operator.

¢ Set Value to the value you wish to compare.

e Check case sensitive to use case sensitive matching for text.

Notes
e The THEN and ELSE values can use column variables. For example:

IF x =0
THEN S$ (1)
ELSE
$(2)

e You can simulate OR with multiple IF statements. For example:

IF x = 10R Yy =2
THEN 3
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Is equivalent to:

IF x =1
THEN 3
ELSE IF y = 2
THEN 3

e Number, date and text values are treated differently for Equal to, Greater than, Less
than, Greater than equal, Less than equal and Not equal to operations. Any values that
can be converted to a number will be treated as a number. Any values that match the
supported date formats in Preferences will be treated as a date.

e All values are treated as text for Contains, Starts with, Ends with, Matches regex, Is not,
Doesn't start with, Doesn’t end with and Doesn't match regex operations.

e Comparisons of text are whitespace sensitive. You can use Whitespace to remove
whitespace before filtering and Replace to get of other unwanted characters (e.g.
whitespace inside the text).

¢ See here for more details on Regular expressions (regex).

See also

e Lookup
2.3.21 Insert

Description
Append/prepend text to one or more columns.

Inputs
One.

Options

e Check the column(s) you wish to transform.

¢ In Insert put the text you want to insert. You can use a column variable.
¢ In At put the position you want the text inserted.

Notes
¢ You can use Whitespace to remove whitespace before inserting.

See also

e Pad
e Extract
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2.3.22 Interpolate

Description
Interpolate values for a dataset based on numerical sample-value pairs in another dataset
and puts the result in a new column.

Examples

If you have time and temperature datasets for sensors A and B with different sampling
frequencies, you merge the two datasets by interpolating the temperature values of B for
for the times A was measured.

First dataset:

time A temperature A
100 1.134
iz 1.0 3.778
320 2.773
4 3.0 5.039
54.0 3.333
6 5.0 2.874

Second dataset:

time B temperature B
100 0.000
220 1334
340 2.697
46.0 3931

Interpolation transform:
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sensor-A.csv
v

2 cols x 6 rows

-JInterpolate

3 cols x 6 rows

sensor-B.csv
v

2 cols x 4 rows

Interpolate @ CF Eg
Top Sample column: time A hs
Bottom Sample column: time B =
Bottom value column: temperature B v
Interpolation type: Linear =

Result:
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| time A temperature A Interpolate temperature B

100 1.134 0
I2 1.0 3.778 0.667
320 2.773 1334
430 5039 2.015
54.0 3.333 2.697
650 2.874 3.314

Inputs

Two.

Options

e Place the dataset you want to modify as the top input and the dataset you want to
sample values from as the bottom input.

¢ Select Top sample column for the column whose values you wish to sample.

¢ Select Bottom sample column for the column that matches the top sample column in
the bottom dataset.

¢ Select Bottom value column for the column that contains the values.

¢ Set Interpolation type to the type of interpolation you wish to use.
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Piecewise interpolation (image from Wikipedia)
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Linear interpolation (image from Wikipedia)

Notes

e If your sample is below the first sample in the bottom dataset, the first value will be
returned.

e If your sample is above the last sample in the bottom dataset, the last value will be
returned.

e Easy Data Transform will try to guess sensible default values for Top sample column,
Bottom sample column and Bottom value column based on column contents.

e If the first input has a header, this will be used for the output.

e The new column is added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.

e Use Num Format to change the precision of the results.

e Messages are shown in the Warnings tab for non-numeric values in either dataset.

e Messages are shown in the Info tab for Top sample column outside the range of values
in Bottom sample column .
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See also

e Lookup

e Join
2.3.23 Intersect

Description
Keep only rows from the top dataset with key values that are present in the lower dataset.

Inputs

Two.

Options

e The output depends on the vertical (Y-axis) position of the inputs.

¢ Select Top key column for the column you want to match in the top input dataset.

¢ Select Bottom key column for the column you want to match in the bottom input
dataset.

Notes

o If there are 10k rows or less in both datasets, Easy Data Transform will try to guess
sensible default values for Top key column and Bottom key column based on column
header names and contents.

e If the first input has a header, this will be used for the output.

o All values are treated as text and comparisons are case and whitespace sensitive. You can
use Case to change the case and Whitespace to remove whitespace before the intersect.

¢ Does not remove duplicates. You can use Unique to do this.

e You can use Concat Cols to join several columns together (e.g. 'first name' and 'last name'
columns) to form a key column.

e You can use Row Num to create a unique key column.

See also
e Subtract

2.3.24 Javascript

Description
Create a custom transform using Javascript (ECMAScript).

Easy Data Transform allows you to carry out a wide range of data transformations without

programming. But sometimes you might need a specialist transformation that can't be done
with the built-in transforms. For that you can use the Javascript transform. It allows you to
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write the body of a Javascript function, to calculate a value for each row in a new column.
Existing column values can be used as variables.

Javascript is a fully-fledged programming language and can perform arbitrarily complex
transforms. It can handle numbers, dates and text.

Examples
To multiply the value in column 'items' by the value in column ‘item price":

return $(items) * $(item price);

To concatenate 'last' and 'first' columns with a comma and a space:

return S$(last) + ', ' + S$(first);

To calculate the biggest of columns 'v1' and 'v2"
return Math.max( $(vl), $(v2) );

To determine whether phone numbers in the '‘phone_num' column are valid using a regular
expression:

const validPhoneNum = /~[\+]12[(12[0-9]1{3}[)]12[-\s\.]12[0-91{3}[-\s\.1?2[0-91{4,6}$/;
if ( validPhoneNum.test ( $(phone num) ) )

return "valid";
else

return "invalid";

To replace the last comma in the 'Location' column with a '} using a regular expression:

return $(Location).replace(/(.*), ([~ 1*)S$/, 'S1;$2');

To calculate the number of years difference between Javascript compatible dates in column
1 and column 2:

return new Date( $(1) ).getFullYear() - new Date( $(2) ).getFullYear();

To calculate the number of milliseconds between a datetime in the 'datetime' column and
1st Jan 2000:

return new Date( $(date) ) - new Date( "2000-01-01T00:00" );

To calculate the number of whole days difference between a date in the 'created' column
and today (negative for future dates):

return Math.floor( ( new Date() - new Date( $(created) ) ) / ( 1000*60*60*24 ) );
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To use the value of the 'n' column if it is a number and O if it isn't:

if ( isNaN( $(n) ) )
return O;

else
return $(n);

To reverse the text in the 'key' column:

var newString = $(key);

for (var i = a.length - 1; i >= 0; i--) {
newString += al[il];

}

return newString;
You can use functions:

function metersToFeet ( x )

{
return 3.28084 * x;

}

return metersToFeet ( $(meters) );

Inputs
One.

Options

e Enter your script into the Javascript field. The script should be the body of a Javascript
function.

e Select a column from Insert variable to add that column variable into the Javascript field
at the current cursor position.

¢ Click the Evaluate button to evaluate your Javascript expression over every row and show
any errors.

Notes
e The Javascript transform is calculated every time:
o The Evaluate button is pressed.
o The Javascript transform item is unselected in the Center pane and script changes have
been made without the Evaluate button being clicked.
o An item upstream of it changes.

e Numeric values should use dot ('.") as the decimal separator and have no group separator.
E.g. 1234.5 is valid, but 1,234.5 and 1.234,5 are not, regardless of the locale set in the
Preferences window. You can use the Num Format and Replace transforms to put
numeric data in the correct format before processing a Javascript transform.
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e The new column is added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.

e The Javascript Date() object evaluates to the number of milliseconds since 1 January 1970
uTcC.

¢ Date values passed to Javascript Date() objects should be in ISO ('yyyy-mm-dd’) format,
e.g. '2020-01-31" (not '2020-1-31").

e If you want to carry out your transform across more than one dataset, you should merge
them first, e.g. using Join.

e The Javascript transform is very versatile and quite fast. But is not as fast as built-in
transforms. So we recommend you use built-in transforms where possible.

e Javascript running in Easy Data Transform is not 'sandboxed' and has the same privileges
as the Easy Data Transform executable. However the Javascript does not have access to
window(), XMLHttpRequest() or ActiveXObject(). So we aren't aware of any way that a bad
actor could damage your system from Javascript sent in a .transform file.

e Javascript is far too big a topic to cover here. However there are many detailed resources
online. If you are stuck contact support.

e If you only want to combine text from columns, use the simpler Substitute transform.

e Warnings are shown in the Warnings tab for:

o Javascript syntax errors
o Ambiguous column references
e For simple arithmetic operations on numbers and dates use the Calculate transform.

See also
e Find the difference between dates/datetimes

2.3.25 Join

Description
Merge two inputs based on common (key) columns, e.g. on an email address or id column
present in both inputs.

Examples
Joining these two datasets by the ID column in each:
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Name ID DOB ID Department Level
lﬁn Black 001 1966*0?35 1601 Engineering 1)
2 Paul White 002 1973-03-11 2|003 Engineering 2

3 Barry Green 003 1977-12-30 I 3|004 Marketing 1

4 Jane Brown 004 1980-11-03 41002 Sales 2

5 Sales 3
Q0 %

i

IEKJilTaupe D05 1981-[!3-_{})

Gives:

Mame 1D DOB Department Level

1 dgf:n Black Gﬂl\mﬁﬁ-ﬂ?—ﬂ Engineering 1 )
2 |Paul White | 002 1973-03-11 Sales 2
3|Barry Green{ 003 [1977-12-3( Engineering 2

4)ane Brown| 004 [L980-11-03 Marketing 1

wTaupe @31981—{13—(}“5&@3 3

(%]

Inputs

Two.

Options

e The output depends on the vertical (Y-axis) position of the inputs.

¢ Select Top key column for the column you want to match in the top input dataset.

¢ Select include top non-matching rows if you want to include in the output any rows in
the top input with no matching value in the bottom input.

¢ Select Bottom key column for the column you want to match in the bottom input
dataset.

e Select include bottom non-matching rows if you want to include in the output any rows
in the bottom input with no matching value in the top input.
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include top non-matching include bottom non- Also known as:

rows checked matching rows checked

No No Inner join

No Yes Right outer join

Yes No Left outer join

Yes Yes Full outer join
Notes

¢ Join merges two datasets side-by-side (horizontally). To merge datasets one on top of the
other (vertically) use Stack.

e If there are 10k rows or less in both datasets, Easy Data Transform will try to guess
sensible default values for Top key column and Bottom key column based on column
header names and contents.

e All values are treated as text and comparisons are case and whitespace sensitive. You can
use Case to change the case and Whitespace to remove whitespace before the intersect.

o If a key value occurs M times in the first dataset and N times in the second dataset, you
will get M x N rows with this key value. You can use Unique to remove rows with duplicate
key values.

e Use Concat Cols to join several columns together (e.g. ‘first name' and 'last name'
columns) to form a key column.

e Use Row Num to create a unique key column.

e Use Sort to sort the results.

e Use the Cross transform for cross joins.

e Messages are shown in the Warnings tab for keys that occur more than once in either
dataset (duplicates).

e Messages are shown in the Info tab for keys that only occur in 1 of the 2 datasets
(misses).

e Cascade multiple joins to join more than 2 datasets.
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cust omers. coy
o

1l s ¥ rows

Join
o
24 ma w130 Mw i

arders.csv
o

34 oo K B30 el

order-details.
W

% cols x 3. Jkrown

suppliers.csv
12 com w I rows JCII'I

51 coi x 2.3k mwa

See also

¢ Video: How to join Excel files
e Cross

e Lookup

e Interpolate

e Merge datasets

2.3.26 Lookup

Description
Looks up the values of a column in the top input dataset in the bottom input dataset and
puts the result in a new column.

Examples

If you have one dataset with category IDs and another dataset with category IDs and
category names, you can create a new category name column in the first dataset by looking
up the category ID in the second dataset.

First dataset:

Easy Data Transform © 2021 Oryx Digital Ltd


https://www.screencast.com/t/aE7Rib6uH8l

Reference

ProductlD ProductName SupplierlD CategorylD
11 Chai 1 1
12 |12 Chang 1 1
3 3 Aniseed Syrup 1 2
!4 4 Chef Anton's Cajun Seasoning 2 2
5 5 Chef Anton's Gumbo Mix 2 2

Second dataset:

CategorylD |CategoryName Description
1)1 Beverages Soft drinks coffees teas beers and ales
22 Condiments  Sweet and savory sauces relishes spreads and seasonings
33 Confections Desserts candies and sweet breads

Lookup transform:

products.csv

4 cols x 77 rows

v Lookup

5 cols x 77 rows

categories.csv

3 cols x8 rows
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Lookup @ 3 ;
Top lookup column: CategorylD >
Bottom lookup column: CategorylD v
Bottom value column: CategoryName X
Bottom values used: First v
If no match: Use no match value ~
No match value:
Comment:
Result:
ProductlD ProductName SupplierlD CategorylD Lookup CategoryName
11 Chai 1 1 Beverages
2 |2 Chang 1 1 Beverages
3 3 Aniseed Syrup 1 2 Condiments
4 4 Chef Anton's Cajun Seasoning 2 2 Condiments
55 Chef Anton's Gumbo Mix 2 2 Condiments
Inputs
Two.
Options

¢ Place the dataset you want to modify as the top input and the dataset you want to lookup
values from as the bottom input.

¢ Select Top lookup column for the column whose values you wish to lookup.

¢ Select Bottom lookup column for the column that matches the lookup in the bottom
dataset.

¢ Select Bottom value column for the column that contains the values.

¢ Set Bottom values used to First if you want use the first match in Bottom lookup
column and All if you want to use all matches.

¢ Set If no match to Use not match value or Leave unchanged depending on what you
want to do for values in Top lookup column that do not exist in Bottom lookup
column.
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¢ Set No match value to the value you want to use for values in Top lookup column that
do not exist in Bottom lookup column when If no match is set to Use no match value.

Notes

e Easy Data Transform will try to guess sensible default values for Top lookup column,
Bottom lookup column and Bottom value column.

e Bottom values used is only important if there are duplicate values in the Bottom lookup
column.

e If the first input has a header, this will be used for the output.

o All values are treated as text and comparisons are case and whitespace sensitive. You can
use Case to change the case and Whitespace to remove whitespace before the intersect.

e If you want to lookup values in multiple columns, use Concat Cols to join several columns
together to form new columns.

e The new column is added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.

e Warnings are shown in the Warnings tab for:
o Values that cannot be found in the bottom dataset (misses).
o Values that occur more than once in the bottom dataset (duplicates), if Bottom values

used is First.

See also
o If

e Interpolate
e Join

2.3.27 New Col

Description
Adds a new column, filled with a given value.

Inputs
One.

Options
¢ Set New column value to the value for every cell of the new column. You can leave it
blank for an empty column.

Notes
¢ New columns are always added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.
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See also

e Copy Cols
e Remove Cols

2.3.28 Num Format

Description
Change the number format in one or more columns.

Inputs
One.

Options

e Check the column(s) you wish to transform.

e Set Format to the new number format (see below).

e For the e, E, and f formats, Precision represents the number of digits after the decimal
point. For the g and G formats, Precision represents the maximum number of significant
digits (trailing zeros are omitted). For the s format Precision is ignored. The following
number formats are supported:

Format Meaning

€ Format as [-]9.9e[+]|-]999.
E.g. 1234567.89 is shown as 1.235e+06.

E Format as [-]9.9E[+]-]999.
E.g. 1234567.89 is shown as 1.235E+06.

£ Format as [-]9.9.

E.g. 1234567.89 is shown as 1234567.89.
g Use e or f format, whichever is the most concise.
G

Use E or f format, whichever is the most concise.

The shortest accurate representation for the given
number without exponents.
E.g. 1234567.00 is shown as 1234567.

¢ Check use group separators to include the group separators for your locale. E.g. to turn
1234567 to 1,234,567 for a UK or US locale.

¢ Set Non-numeric according to what you want to do with non-numeric values in
transformed columns. NaN means Not a Number.
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Notes

¢ The Locale set in the Preferences window is used to decide how the number is
represented (e.g. group and decimal separators).

e Non-numerical values are ignored.

¢ You can also use Extract and Pad to change the number of characters.

e Warnings are shown in the Warnings tab for non-numeric values.

See also
e Date Format

2.3.29 Pad

Description
Pad text to a minimum length in one or more columns.

Inputs
One.

Options

e Check the column(s) you wish to transform.

e Set Minimum length to the length you want values in selected columns padded to.
Values this length or longer are unaffected.

e Set Pad to Left or Right depending on where you want any padding characters added.

¢ Set Pad with to the character you want to pad with.

Notes
e Whitespace is counted when calculating length. You can use Whitespace to remove
whitespace before padding.

2.3.30 Pivot

Description
Creates a pivot table to summarise values for one or two columns.

Inputs
One.

Options

¢ Set Column to the column values you want to use as columns in your pivot table.
¢ Set Rows to the column values you want to use as rows in your pivot table.

¢ Set Values to the column you wish to summarize.
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e Set Summarize by to how you wish to summarize the values:
o Sum show the sum of the values. Non-numeric and empty values are ignored.
o Minimum shows the smallest value. Non-numeric and empty values are ignored.
o Maximum shows the largest value. Non-numeric and empty values are ignored.
o Average shows the arithmetic mean of the values. Non-numeric and empty values are
ignored.
o Median shows the median of numeric values in the column. Non-numeric and empty
values are ignored.
o Mode shows the mode of numeric values in the column. Non-numeric and empty
values are ignored.
o Standard deviation is the sample standard deviation (equivalent to Excel function
stddev.s). Non-numeric and empty values are ignored.
o Count shows the number of values. Empty values are ignore (a value that contains
whitespace is not considered empty).
¢ Set Set non-calculated depending on how you want to set cells not calculated by the
pivot.
e Check add totals to add row and/or column totals.

Notes

e Mode may not work as expected with non-integer values, due to precision issues. You
can fix this by using a Num Format transform first.

e Use Num Format to change the precision of the results.

See also
e Count
e Stats

e Summary
2.3.31 Remove Cols

Description
Removes columns.

Inputs
One.

Options

e Uncheck the column(s) you wish to remove.

Notes
e The column will be removed from any dataset ‘downstream’.

Easy Data Transform © 2021 Oryx Digital Ltd



Reference

See also
e New Col

2.3.32 Rename Col (deprecated)

This transform is deprecated. Use Rename Cols instead.

Description
Rename a column header.

Inputs
One.

Options
e Select the column header you wish to rename in Column.
¢ Set Rename to to the new column header name.

Notes
e The names of column headers do not have to be unique.

2.3.33 Rename Cols

Description
Rename column headers.

Inputs
One.

Options

e Change the column headers using the New name column.

e Click Lower to change all the names in the New name column to lower case.

¢ Click Upper to change all the names in the New name column to upper case.

e Click Title to change all the names in the New name column to title case.

e Click Reset to change all the names in the New name column back to their original name.

Notes
e The names of column headers do not have to be unique.
e Warnings are shown in the Info tab for duplicate column names (case sensitive).
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2.3.34 Reorder Cols

Description
Reorder columns.

Inputs
One.

Options

Drag the columns into the desired order (left-most at the top).

Click the Move first button to move the selected columns to be first.

Click the Move up button to move the selected columns up one place.

Click the Move down button to move the selected columns down one place.
Click the Move last button to move the selected columns to be last.

Click the Reset button to restore the original column order.

Notes
You can also rename columns with Rename Cols and remove unwanted columns with
Remove Cols.

2.3.35 Replace (deprecated)

This transform is deprecated. Use Replace instead.

Description
Replace text in one or more columns.

Examples
To turn 0123456789 into (+44) 1234 56789 using a Regular expression:

Match type: Regex v
Replace:  0(\d\d\d\d)(\d\d\d\d\d)

With: (+44)\1\2

Inputs
One.
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Options

e Check the column(s) you wish to transform.

e Choose the Match type as:
o Text to replace matches contained in the text.
o Exact text to replace the text only if it matches exactly (whitespace sensitive).
o Regex to match using a Regular expression.
o Empty to match empty cells (cells with whitespace are not empty).

¢ In Replace put the text you want to replace for Text, Exact text or Regex matching. You
can use a column variable.

¢ In With put the text you want to replace it with. You can use a column variable.

e Check case sensitive to use case sensitive matching for Text, Exact text or Regex
matching.

Notes

e Comparisons are whitespace sensitive. You can use Whitespace to remove whitespace
before replacing.

See also

e Insert
e Substitute

2.3.36 Replace

Description
Replace text in one or more columns.

Examples
Replacing US state initials:
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First Last Address

1 Jane  Smith 100 W St, Tucson, AZ

2 Ahmed Ali 17 N St, Anchorage, AK

3 Josh Jones 123 S St, Fort Smith, AR

|

Replace O =P
E] Q Filter columns
First

Last
v Address

1 of 3 columns selected

CENRAS)

Match Type Replace With
1| Text ¥ AK Alaska
2| Text ¥ AR Arkansas
3| Text v AZ Arizona

v case sensitive

|

First Last Address

1Jane  Smith 100 W St, Tucson, Arizona

2 Ahmed Ali 17 N St, Anchorage, Alaska

3 Josh  Jones 123 S St, Fort Smith, Arkansas

Reformatting phone numbers using a regular expression:
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Home Business

10123456789 0123489404

2 0139384892 0129347236

3 0153498348 0150923403

Replace OFE
E’ Q Filter columns i

v Home
v/ Business

2 of 2 columns selected

G,
Match Type Replace With i
1 Regex ¥ O(d\d\d\d)(\d\d\d\d\d) (+44)\1\2 '
Home Business

1 (+44) 1234 56789 (+44) 1234 89404
2 (+44) 1393 84892 (+44) 1293 47236

3/(+44) 1534 98348 (+44) 1509 23403

Replacing empty values:
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ni n2 n3
1123.8 9789.1

2981234 23.3

{

Replace @ F BB
E Q Filter columns

v ni
v n2 f
v n3

32838

KA
KN

3 of 3 columns selected

CNRAS

|
Match Type Replace With f
|

1 Empty v ‘ 0.0
ni nZ n3

11238 9789.1 0.0
2981234 0.0 23.3

3288 0.0 0.0

Inputs
One.

Options

e Check the column(s) you wish to transform.
e Add the terms you wish to replace and how you wish to replace them.
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o Choose the Match type as:
» Text to replace matches contained in the text.
» Exact text to replace the text only if it matches exactly (whitespace sensitive).
= Regex to match using a Regular expression.
= Empty to match empty cells (cells with whitespace are not empty).
o In Replace put the text you want to replace for Text, Exact text or Regex matching.
You can use a column variable.
o In With put the text you want to replace it with. You can use a column variable.
e Check case sensitive to use case sensitive matching for Text, Exact text or Regex
matching.

Notes

e Comparisons are whitespace sensitive. You can use Whitespace to remove whitespace
before replacing.

See also
e Insert
e Substitute

2.3.37 Row Num

Description
Add a new column that contains the row number.

Inputs
One.

Options

e Set Start at to the number you want to use for the first row.

¢ Set Increment to the amount you wish to increment by.

e set Every to how often to apply the increment (e.g. set to 5 to increment once every 5
rows).

Notes
e The new column is added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.

2.3.38 Sample

Description
Selects a subset of rows from the input.
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Inputs
One.

Options

¢ Set Rows to the number of rows you want to output. If it is the same or greater than the
number of rows in the input, then the input will be unaffected.

¢ Set Select depending on how you want the rows sampled.

¢ Check disable sampling to turn off sampling. If sampling is disabled, the transform does
nothing.

Notes

e If you set Select to Randomly (for quality) or Randomly (for speed), rows will be
selected using a pseudo-random number generator, initialized with Random seed.
Changing the seed will change the rows sampled.

e With the same Random seed and the same Select value you should get the same
random sampling, even across Windows and Mac versions of Easy Data Transform.

e Random (for speed) is significantly faster than Randomly (for quality), but the results
may be less random.

e If you are transforming a large dataset, then you can use Sample to test a small subset.

e If you need to do something more complex than Sample can handle (e.g. keep only rows
500 to 1000) then use Slice or Row Num followed by a Filter. For the most complex cases
use Row Num, followed by Javascript, followed by a Filter. E.g. this Javascript function
returns 1 for every 10th row between 1000 and 2000 and 0 otherwise:

return $(Row Num) >= 1000 & $(Row Num) <= 2000 & $(Row Num) % 10 == 0;
2.3.39 Slice

Description
Keep or remove a continuous section of rows.

Examples
To keep only the records between the YEAR rows in this data:
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1 2 5 4 5 6 7
1 YEAR JAN FEB MAR APR MAY JUN

2 1980 267.72 267.81 267.85 267.96 268.18 268.05
3 1981 267.35 267.38 267.66 267.86 267.98 267.55
4 1982 267.39 267.40 267.56 267.68 267.96 267.82 .
5 1983 268.20 268.06 268.38 268.51 268.44 267.93
6 1984 267.09 267.36 267.62 267.62 267.59 267.41
7 1985 267.09 267.27 267.45 267.58 267.81 267.32
8 YEAR JAN FEB MAR APR MAY JUN

9 1986 267.35 267.38 267.66 267.86 267.98 267.55

10 1987 267.09 267.36 267.62 267.62 267.59 267.41 .

Keep the slice from the first YEAR row to the next YEAR row and don't include the 'From’
and 'To' rows:
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Slice @ f_*f’ Eﬂ
Mode: Keep v
From: First row where v |
Column: 1 v
Matches: = Equal to =
Value: YEAR

include 'From' row

To: MNext row where v
Column: 1 v |
Matches: = Equal to v

Value: YEAR

include 'To' row

To give:

1 2 3 4 5 6 7
11980 267.72 267.81 267.85 267.96 268.18 268.05

2 1981 267.35 267.38 267.66 267.86 267.98 267.55
31982 267.39 267.40 267.56 267.68 267.96 267.82
4 1983 268.20 268.06 268.38 268.51 268.44 267.93
51984 267.09 267.36 267.62 267.62 267.59 267.41

6 1985 267.09 267.27 267.45 267.58 267.81 267.32

Inputs
One.
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Options

¢ Set Mode depending on whether you want to keep or remove the slice.

Set From according to how you want to choose the first row of the slice.

Set Column, Matches and Value to match the first row.

Uncheck Include ‘From' row if you don't want to include the first row in the slice.
Set To according to how you want to choose the last row of the slice.

Set Column, Matches and Value to match the last row.

Uncheck Include 'To’ row if you don't want to include the last row in the slice.

e Check case sensitive to use case sensitive matching for text.

Notes

e Number, date and text values are treated differently for Equal to, Greater than, Less
than, Greater than equal, Less than equal and Not equal to operations. Any values that
can be converted to a number will be treated as a number. Any values that match the
supported date formats in Preferences will be treated as a date.

e All values are treated as text for Contains, Starts with, Ends with, Matches regex, Is not,
Doesn't start with, Doesn't end with and Doesn't match regex operations.

e Comparisons of text are whitespace sensitive. You can use Whitespace to remove
whitespace before filtering and Replace to get of other unwanted characters (e.g.
whitespace inside the text).

e See here for more details on Regular expressions (regex).

e If you want to keep or remove a selection of rows by row number, use a Row Num
transform followed by a Filter transform.

2.3.40 Sort

Description
Sorts rows by one or more columns.

Inputs
One.

Options

e Click the '+' button to add a new sort level.

e Click the 'x' button to delete the selected sort level(s).

e Click the up arrow to move the selected sort level(s) up.

¢ Click the down arrow to move the selected sort level(s) down.

¢ Set Column to the column you want to sort by.

¢ Set Order depending on whether you want to sort this column Ascending or
Descending.
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Notes

e If you add multiple levels, it will sort by level 1 then level 1 values that are the same will be
sorted by level 2 etc.

e Number, date and text values are treated differently for comparison purposes.

e Any values that can be converted to numbers will be treated as numbers.

e Any values that match the supported date formats in Preferences will be treated as dates.

e Comparisons of text are case and whitespace sensitive. You can use Case to change the
case and Whitespace to remove whitespace before sorting.

2.3.41  split Col

Description
Split text at delimiters in a selected column to create multiple columns or rows.
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Examples
Name Courses
1 Alice C001,H005
2 Bob  P002
3 Charlie €001,P003
4 Denzil E0O7,C001,HO05
Split Col Split Col
Column: Courses Column: Courses
Delimiter: Delimiter:
Into: Into:
Ordering:  Current Ordering:  Current
Mame Courses
1 Alice C001
Name Courses Courses1 CoursesZ2 Courses3 > Alice  HO05
1 Alice C001,H005 com HO05
3 Bob P002

2 Bob  P002 P002

4 Charlie €001
3 Charlie C001,P003 Ccoo ‘PWS

5 Charlie PO0O3
4 Denzil E007,C001,H00S EOO7 ‘com |H005

6 Denzil EOO7

7 Denzil C0OO01

8 Denzil HOOS
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Inputs
One.

Options

e Select the Column you wish to split.

e Supply the Delimiter for splitting the column (e.g. comma).

¢ Set Into to:
o Columns to create a new column for each split value.
o Rows to create a new row for each split value (the original row is removed).

¢ Set Ordering depending on how you want to order values after splitting.

e Check keep empty if you wish to keep empty values (e.g. honor delimiters with nothing
in between).

¢ set Min. values to the minimum number of columns/rows you wish to split each value
into.

¢ set Max. values to the maximum number of columns/rows you wish to split each value
into (ignored if less than minimum).

Notes

e If no Delimiter is supplied then no new columns are created.

e If Into is Columns, new columns are added at the right end. You can change the column
order with Reorder Cols.

e If there is a header, the header of the new column is based on the original header. You
can change the column name with Rename Cols.

e The opposite of Split Col with Into as Columns is Concat Cols.

See also
e Split Rows

2.3.42 Split Rows

Description
Split each row into multiple rows.

Examples
Splitting these rows:
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| Guest title Guest first name Guest last Spouse title Spouse first name Spouse last name

1 Mr John Smith Dr Jane Smith

2 Mr Bill Brown Mrs Andrea Brown

Before each column containing 'title":

Split Rows

Split each row:
® before each column where name ¢~ title

Gives:
Guest title Guest first name Guest last
1 Mr John Smith
EII ||Il: If

3 Mr Bill Brown

4 Mrs Andrea Brown
Inputs
One.
Options

e Split by column name:
o Each row will be split before each column that matches the criteria.

¢ Split a fixed number of times:
o Define the number of times you want to split each row, starting before which column
and then every N columns.
o The split is added before the designated columns.
o Splits after the last column are ignored. So you can set times to a large number if you
don't know how many columns there will be.
¢ Split automatically:
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o Find the first column name that appears more than once and split each row before each
column with that name.
e Check case sensitive to use case sensitive matching for column names.

Notes

e Comparisons of column names are whitespace sensitive.

e Use the keyboard up and pown arrow keys to move the focus between the ‘radio’ buttons.

e Splits added before the first column are ignored, as there is already a split there.

e Use New Col or Rename Cols if you need to add additional columns or rename columns
before splitting rows.

e The opposite of Split Rows is Concat Rows.

See also
e Gather

e Split Col
2.3.43 Spread

Description
Spread a column into multiple new columns. Also called wide pivot or crosstab.

Examples
salesman area Quarter Amount

1 Alice North Q1 11.3

2 Alice ;

3 Alice ;

4 Alice ;

5 Bob 4.5

6 Bob 79

7 Bob 8

8 Bob 3.3
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With Quarter and Amount columns spread:

I

R A}

Spread ¢ ul
Key column: Quarter v

Value column: Amount v |

Gives:
salesman area QITIQ2NIQ3 G4
1 Alice North 11.3 893 443 18
2 Bob East 45 79 8 3.3

Inputs

One.

Options

e Select the Key column and Value column you wish to spread.

¢ Missing values is used for values missing from the input dataset.

¢ set Min. new cols to the minimum number of new columns you wish to add.

¢ set Max. new cols to the maximum number of new columns you wish to add (ignored if
less than minimum).

Notes
e If there are rows that are duplicates, apart from the value column, this will cause errors.
e New columns are added at the right end. You can change the column order with Reorder
Cols.
¢ You can merge the new columns into a single column with Concat Cols.
e The opposite of Spread is Gather.
2.3.44 Sstack

Description
Merge rows from inputs, one on top of the other.

Example
Stacking these two datasets:
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MName ID DOB

John Black 001 01/07/1966

Paul White 002 11/03/1973

Barry Green 003 30/12/1977,

+

i Name ID DOB

Jane Brown 004 03/11/198

! Jill Taupe 005 01/03/198

Gives:

Name 1D DOB
1@1_:1 Black 001 1966-07-01

2 |Paul White 002 1973-03-11

3 ww Green 003 19??—12—_55})

4 Jane Brown 004 1980-11-0\

51;1\|Taupe 005 1981—(]3-[5}

Inputs

One or more.

Options

¢ Select Align columns by to Header name if you want line up column values by header
name (e.g. the 'id' column in input 1 with the 'id' column in input 2) and Column number
to align by the column number (e.g. the first column of input 1 with the first column of
input 2). The headers will be matched in order:
o case and whitespace sensitive (e.g. 'ID' to 'ID'); then
o case insensitive and whitespace sensitive (e.g. 'ld' to 'ID"); then
o case sensitive and whitespace insensitive (e.g. 'ID' to ' ID *); then
o case and whitespace insensitive (e.g. 'ld" to ' ID )

e The stacking order depends on the vertical (Y-axis) position of the inputs.
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Notes

e Stack merges two datasets one on top of the other (vertically). To merge datasets side-by-
side (horizontally) use Join.

e If you align by Column number the header of the first input is used.

e Messages are shown in the Warnings tab for duplicated column names within an input
dataset when Align columns by is set to Header name.

See also

e Cross

e Join

e Merge datasets
2345 Stamp

Description
Adds a time/date stamp as a new row or a new column.

Inputs
One.

Options

e Supply the processing date/time format in Format (see below).

Format Meaning

d The day as number without a leading
zero (1to 31)

cle. The day as number with a leading zero
(01 to 31)
ddd The abbreviated localized day name

(e.g. '‘Mon' to 'Sun’). Uses the system
locale to localize the name.

grlelel The long localized day name (e.g.
‘Monday' to 'Sunday'). Uses the system
locale to localize the name.

M The month as number without a leading
zero (1 to 12).
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Format Meaning

MH The month as number with a leading

zero (01 to 12)

MM The abbreviated localized month name
(e.g. Jan' to 'Dec’). Uses the system
locale to localize the name.

elLely! The long localized month name (e.g.
‘January' to 'December’). Uses the
system locale to localize the name.

Yy The year as two digit number (00 to 99).

yyyy The year as four digit number. If the
year is negative, a minus sign is
prepended in addition.

h The hour without a leading zero (0 to
23 or 1 to 12 if AM/PM display).

hh The hour with a leading zero (00 to 23
or 01 to 12 if AM/PM display).

H The hour without a leading zero (0 to
23, even with AM/PM display).

B The hour with a leading zero (00 to 23,
even with AM/PM display).

m The minute without a leading zero (0 to
59).

mm

The minute with a leading zero (00 to
59).

The whole second without a leading
zero (0 to 59).

SS The whole second with a leading zero

where applicable (00 to 59).

The fractional part of the second, to go
after a decimal point, without trailing
zeroes (0 to 999). Thus "s.z" reports the
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Format Meaning

seconds to full available (millisecond)
precision without trailing zeroes.

S The fractional part of the second, to
millisecond precision, including trailing.

ap or a Use am/pm display. a/ap will be
replaced by either "am" or "pm".

t The timezone (for example "CEST").

¢ Select from Position whether you want the stamp row added to the start or end of the
dataset or to every row in a new column.

Notes
e If you add the stamp to Every Row you can move the column using Reorder Cols.

See also
e Meta information
2.3.46 Stats

Description
Calculates the sum, minimum, maximum, average, median, standard deviation or mode of
numeric values by column or row in one or more selected columns.

Inputs
One.

Options
e Check the column(s) you wish to calculate stats for.
¢ Set Calculation to the statistic you want to calculate:
o Sum show the sum of the values.
o Minimum shows the smallest value.
o Maximum shows the largest value.
o Average shows the arithmetic mean of the values.
o Median shows the median of numeric values in the column.
o Mode shows the mode of numeric values in the column.
o Standard deviation is the sample standard deviation (equivalent to Excel function
stddev.s).
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e Set On depending on whether you wish to calculate the statistics for columns, rows or
both.
o If On is set to Columns an extra row with the results is added to the bottom.
o If On is set to Rows an extra column with the results is added to the right.
o If On is set to Columns and rows an extra row with the results is added to the bottom
and extra column with the results is added to the right. The bottom right cell
contains the calculation across all values.

Notes

e Non-numerical and empty values are ignored.

e Mode may not work as expected with non-integer values, due to precision issues. You
can fix this by using a Num Format transform first.

e Use Num Format to change the precision of the results.

See also

e Count

e Pivot

e Summary
2.3.47 Substitute

Description
Substitute column values into text.

Examples
To create SQL statements to insert 'Country’, 'Year', 'Key' and 'Value' column values:

INSERT INTO mytable (Country, Year,Key,Value) VALUES ($(Country),$(Year),$(Key),$ (Value
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Substitute

New column name: SQL
Substitution script:

INSERT INTQ mytable(Country,Year,Key,Value) VALUES ($(Country),$(Year),$(Key),$(Value));

Insert variable: <select>

Comment:

Substitute column values into text.

& &
Country Year Key Value saL
1 Afghanistan 1999 cases 745 INSERT INTO mytable(Country,Year,Key,Value) VALUES (Afghanistan,1999,cases, 745);
Inputs
One.
Options

e Enter your substitution script into the Substitution script field.

e Select a column from Insert variable to add that column variable into the Substitution
script field at the current cursor position.

e Click the Evaluate button to evaluate your script over every row.

Notes
e The transform is calculated every time:
o The Evaluate button is pressed.
o The Substitute transform item is unselected in the Center pane and script changes
have been made without the Evaluate button being clicked.
o The item upstream of it changes.
e The new column is added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.
e If you want to carry out your transform across more than one dataset, you should Join

them first.
e If you need to do something more complex than this transform allows, try the Javascript
transform.

e Warnings are shown in the Warnings tab for ambiguous column references.
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2.3.48 Subtract

Description
Remove rows from the top dataset with key values that are present in the lower dataset.

Inputs

Two.

Options

e The output depends on the vertical (Y-axis) position of the inputs.

e Select Top key column for the column you want to match in the top input dataset.

¢ Select Bottom key column for the column you want to match in the bottom input
dataset.

Notes

e If there are 10k rows or less in both datasets, Easy Data Transform will try to guess
sensible default values for Top key column and Bottom key column based on column
header names and contents.

o If the first input has a header, this will be used for the output.
e All values are treated as text and comparisons are case and whitespace sensitive. You can
use Case to change the case and Whitespace to remove whitespace before the subtract.
¢ All rows in the top dataset with a given key value are removed if that key value occurs 1 or
more times in the bottom dataset.

e You can use Concat Cols to join several columns together (e.g. 'first name' and 'last name'
columns) to form a key column.

e You can use Row Num to create a unique key column.

See also
e |ntersect

2.3.49 Summary

Description
Summarise the values in the selected columns.

Inputs
One.

Options

¢ Select the Columns you wish to summarise.
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¢ Check include dates if you wish to check for date values using supported date formats.
This can be slow for large datasets.

¢ Check include statistics if you wish to add the sum, average, median and standard
deviation for numeric values.

Notes

e Whether values are interpreted as number or dates depends on Supported date formats
and Locale in the Preferences window.

e Empty values is the number of values in the column that are completely empty. Values
with whitespace do not count as empty.

¢ Non-empty values is the number of values in the column that are not completely empty.
Values with whitespace do not count as empty.

¢ Numeric values is the number of numeric of values in the column that can be interpreted
as a number.

e Integer values is number of numeric of values in the column that can be interpreted as
integers (whole numbers). "1.0" (depending on your Locale), "0", "-1" and "1e3" are
considered integers.

¢ Date values is the number of values in the column that can be interpreted as a date. Only
shown if check for dates is checked.

¢ Text values is the number of values in the column that cannot be interpreted as empty,
numeric or date.

e Distinct values is the number of different values in the column. Date and numeric values
are treated as text (e.g. '7' is treated as different to '7.0' and '1/1/2020" is treated as
different to '01/01/2020"). Comparison between values is sensitive to case and whitespace.
Empty values are not counted.

¢ Unique values is the number of values that only occur once in the column. Date and
numeric values are treated as text. Comparison between values is sensitive to case and
whitespace. Empty values are not counted.

¢ Duplicated values is the number of values that only more than once in the column. Date
and numeric values are treated as text. Comparison between values is sensitive to case
and whitespace. Empty values are not counted.

¢ Min length is the minimum number of characters of a value in the column. Whitespace is
counted. Date and numeric values are treated as text.

e Max length is the maximum number of characters of a value in the column. Whitespace is
counted. Date and numeric values are treated as text.

¢ Min numeric is the minimum numeric value in the column. Non-numeric and empty
values are ignored.

e Max numeric is the maximum numeric value in the column. Non-numeric and empty
values are ignored.

¢ Range numeric is Max numeric - Min numeric.
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e Sum numeric is the sum of numeric values in the column. Non-numeric and empty values
are ignored. Only shown if include statistics is checked.

¢ Average numeric is the arithmetic mean of numeric values in the column. Non-numeric
and empty values are ignored. Only shown if include statistics is checked.

¢ Median numeric is the median of numeric values in the column. Non-numeric and empty
values are ignored. Only shown if include statistics is checked.

¢ Mode numeric is the mode of numeric values in the column. Non-numeric and empty
values are ignored. Only shown if include statistics is checked.

e Stddev numeric is the sample standard deviation (equivalent to Excel function stddev.s)
of numeric values in the column. Non-numeric and empty values are ignored. Only shown
if include statistics is checked.

¢ Variance numeric is the square of the sample standard deviation. Only shown if include
statistics is checked.

¢ Q1 numeric is the first quartile (calculated using Method 1 here). Only shown if include
statistics is checked.

¢ Q3 numeric is the third quartile (calculated using Method 1 here). Only shown if include
statistics is checked.

¢ IQR numeric is the Inter Quartile Range. Only shown if include statistics is checked.

e Skew numeric is the alternative Pearson Mode Skewness (3 * (Mean — Median) /
Standard Deviation ). Only shown if include statistics is checked.

¢ Min date is the minimum date value in the column. Only shown if include dates is
checked.

¢ Max date is the maximum date value in the column. Only shown if include dates is
checked.

¢ Most frequent lists the most common text in the column. Empty values are not counted.
Date and numeric values are treated as text. Comparison between values is sensitive to
case and whitespace.

Notes

e Mode may not work as expected with non-integer values, due to precision issues. You
can fix this by using a Num Format transform first.

e Use Num Format to change the precision of numerical results.

¢ You can use Whitespace to remove any whitespace at the start or end of values before
Summary.

e If you wish to have a row displayed per column you can Transpose the table first.

See also
e Count

e Pivot

e Stats
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2.3.50 Total

Description
Add a new column with a running (cumulative) total of the selected column.

Examples

area transaction

1 North 100
2 South 200
3 North -50
| 4 South 320
5 East 200

6 East -50

Totalling the transaction column:

Total @ (f E:F

Column: transaction v F
:
]

By: <None selected> v |

Gives a running total of transactions:
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area transaction Total transaction
1 North 100 100
2 South 200 300
3 North -50 250
4 South 320 570
5 East 200 770
6 East -50 120

Totalling the transaction column by area:

Total @ dﬁ Eg

Column: transaction v

By: area =

Gives a separate running total for each area:

area transaction Total transaction
1 North 100 100
2 South 200 200
3 North -50 50
4 South 320 520
5 East 200 200
6 East -50 150
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Inputs
One.

Options

e Set Column to the column you want to total.

¢ Set By to a column if you want a separate running total per value in that column. Leave as
<None selected> if you only want a single running total.

Notes

e Non-numerical values are ignored.

e The By column takes account of case and whitespace in values.

e The new column is added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.

See also
e Count

2.3.51 Transpose

Description
Swap (rotate) rows and columns, so that each row becomes a column and each column
becomes a row.

Inputs
One.

Options

e Check has header to make the new first row into a header (requires >1 row).

Notes

e If the input dataset has a header, it will become the new first column. Use Remove Cols to
remove it.

e Datasets with very large numbers of columns can be slow to display.
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2.3.52 Trim (deprecated)

This transform is deprecated. Use Whitespace instead.

Description
Removes leading and trailing whitespace from one or more columns.

Inputs
One.

Options
e Check the column(s) you wish to transform.
2.3.53 Unique

Description
Remove duplicate rows based on keeping only unique values in selected columns

Examples
If you have a dataset of orders:

Name Customer Id Product Id Cost Date
1 Alice Anderson C018930 13574 29.95 01/10/2020

2 Bob Brown 89456 10.55 01/10/2020
3 Charlie Jones CO17783 96352 19.95 02/10/2020 |

4 Robert Brown

98526 10.00 02/10/2020

5 Charles Jones CO17783 38746 25.00 03/10/2020}

And you want to:

e keep one row per unique Customer Id

keep the first listed Name for each Customer Id

e concatenate Product Ids for each Customer Id, delimited by a comma
sum the Costs for each Customer Id

keep the latest Date for each Customer Id
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e add a Count column showing how many rows in the input correspond to each row in the
output
You can set the following:

Unique @ E ﬂ |
Column Option f

1 Name Keep first v |k
2 Customer Id Keep unique ¥ |
3 Product Id Concat bl ¢
4 Cost Sum o '
5 Date Maximum Wl 1
Set  All ¥ |Keep unique ~ I
Keep unique for 1 of 5 columns '
Concat delimiter: , :
Vv add count column |

To get:
Name Customer Id Productld Cost Date Count
1 Alice Anderson C018930 13574 2995 01/10/2020 1
2 Bob Brown B89456,98526 2055 02/10/2020 2
3 Charlie Jones CO17783 96352,38746 4495 03/10/2020 2

Inputs
One.

Options
¢ Set an Option for each column:
o Only 1 row is kept where all the Keep unique columns have the same value.
o Keep first keeps first value in the current sort order.
o Keep last keeps the last value in the current sort order.
o Sum sums any numerical values. Blank values are ignored.
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o Maximum keeps the maximum numerical or date value.
o Minimum keeps the minimum numerical or date value.
o Average takes the average (mean) of any numerical values. Blank values are ignored.
o Concat to concatenate values. Duplicate values are kept. All values are treated as text.
o Concat unique to concatenate values. Duplicate values are ignored. All values are
treated as text.

¢ Use the Set button to quickly set the option value for multiple columns.

¢ Set Concat delimiter if you want to add a delimiter between Concat or Concat unique
values

¢ Check add count column to add a column showing how many rows in the input dataset
created each unique row.

Notes

e Rows are considered duplicates if they have exactly the same value in all the columns set
to Keep unique. Comparisons are case and whitespace sensitive. You can use Case and
Whitespace to change case and whitespace before deduping.

e If no columns are set to Keep unique the transform won't do anything.

e If you are using Keep first or Keep last the sort order is important. You can use Sort to
change the sort order before deduping.

e The Dedupe transform is a less powerful (but simpler and faster) alternative to Unique.

See also
e Dedupe a dataset
2.3.54 Units

Description
Change units of time, length, temperature etc.

Examples
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Units @ Ez

E| Q Filter columns

/(;’— Temperature \\

1 of 1 columns selected

Dimension: Temperature v

From: Celsius/Centigrade v

\Ta: Fahrenheit y
o

Change units of time, length, temperature

etc.

Data  Warni Data Warnings  Comment >
1 col x 7 rows 1 col x 7 rows
C B (s & ¢

Temperature Temperature
1-20 1-4
20 232
320 368
4 40 4 104
5 60 5 140
6 80 6176
7 100 7212

v Clipboard v Units

1 colx 7 rows 1 col x 7 rows
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Inputs
One.

Options

e Check the column(s) you wish to transform.

¢ Set Dimension to the dimensions of the units you wish to convert.
¢ Set From to the units you wish to convert from.

¢ Set To to the units you wish to convert to.

Notes

¢ The Locale set in the Preferences window is used to decide how the number is
represented (e.g. decimal separators).

Unit disambiguation:

o Years are 365.25 days.

o Calories are thermal/small/gram (not nutritional) Calories.

o Miles are International/Statute Miles.

o Nautical miles are International Nautical Miles.

o Gallons (US) are liquid gallons.

o Pints (US) are liquid pints.

Warnings are shown in the Warnings tab for non-numeric values.

e Non-numerical and empty values are not changed.

Use Copy Cols to copy columns before you transform them.

Use Num Format to change the number format of the results.

Use Extract or Split Col to remove any unit symbols from the value before conversion, e.g.
to change "0.0 Kg" to "0.0".

e If you want to convert units not covered here you can do it using the Javascript transform.

2.3.55 Whitespace

Description
Tidy whitespace (spaces, tabs, carriage returns etc) in the selected column(s).

Inputs
One.

Options

e Check the column(s) you wish to transform.

e Check trim leading and trailing whitespace to remove whitespace characters, such as
space and tab.

e Check replace line feeds with spaces to replace LF (\n) characters with spaces.
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e Check replace tabs with spaces to replace tab (\t) characters with spaces.

e Check remove carriage returns to remove CR (\r) characters.

¢ Check convert consecutive spaces to one space to replace 2 or more consecutive spaces
with a single space.

¢ Check remove non-printable characters to remove characters of Unicode type Other_*.
This include ASCII codes 0 to 31, such as tab, line feed, carriage return, bell and
backspace. It does not remove spaces.

Notes

e The operations are carried out in top to bottom order, e.g. Replace line feeds with
spaces is carried out before Convert consecutive spaces to one space.

e Click the eye icon in the Right pane to show whitespace in the data.

Data Warnings Info Comment Results

3 cols x 3 rows

dEW,

A B

Press to show whitespace in the dataset as symbols:
1)1 <121 Space:

- : Tab: -
2 Carriage return:  «
3 a7~ -8 |Line feed: o

Other whitespace: o

See also
e Case

2.4 Output
24.1  Output data

Once you have finished transforming your data you can output it in the following formats:
o CSV

e Excel

* JSON

e HTML

Markdown

o ISV
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e vCard
e XML
¢ YAML

To create an output, select 1 input and/or transform item in the Center pane and then click
the To File button at the bottom of the Left pane. You can choose the file type in the Save
as type drop-down list of the Output window.

You can select the output item in the Center pane and change any options related to the
output in the Right pane.

output.csv @ Eﬂ
File: \andy\Desktop\output.csv ...
Type: Delimited text v
Delimiter: Comma (,) v
Quoting: As needed v
Line endings: Automatic v
Encoding:  UTF-8 v

v Byte Order Mark

Write mode: Overwrite v
Alias: output

Set File to the location of the file you want to output. If you are writing to a .xIs or .xlsx file
the output will be written to a sheet called 'Easy Data Transform' by default. You can change
this by adding the sheet name inside [], e.g. myfile.x1lsx [mysheet].

Set Type to the file type. The default type will be set according to the file extension and the
settings in the Output Extensions tab of the Preferences window.

Set Value types depending on how you want to set JSON types (only available for JSON

files).

¢ Automatic to let Easy Data Transform decide the JSON type depending on the contents
of each column.

e String to set the JSON type for all columns to String

e Manual to choose the JSON type of each column as:
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o Automatic (based on column contents).

o Boolean.

o Number.

o String.
If you output a column as Boolean or Number any values not of that type will be output as
null.

Set Delimiter to the delimiter you wish to use (only available for delimited text files, such as
CSV and TSV).

Set Quoting depending how you want to use quoting in the output (only available for

delimited text files, such as CSV and TSV).

¢ As needed to add " quotes around values that contain the delimiter character, "
characters or carriage returns.

e Always to add " quotes around every value.

¢ Never to never add " quotes around values (delimiters and carriage returns with values
are replaced with spaces).

Set Line endings to the control characters you wish to use to denote line endings (only

available for text files).

¢ Automatic to choose the standard line ending for the current operating system.

¢ Windows (CRLF) to choose the standard Windows line ending, carriage return+line feed
(\r\n).

¢ Mac\Unix (LF) to choose the standard macOS/Unix line ending, line feed (\n).

¢ Old Mac (CR) to choose the standard classic (pre mac OS X) Mac line ending, carriage
return (\n).

Set Encoding to the text encoding you wish to use (only available for text files).

Set Formatting depending on how you want to set the Excel cell formatting (only available
for Excel files).
¢ Automatic to let Easy Data Transform decide cell formatting depending on the contents
of each column.
e General to set the cell format for all columns to 'General'.
e Manual to choose the cell format of each column as:
o Automatic (based on column contents).
o Boolean.
o Date.
o General.
o Number.
o Text.
o Formula.
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Note that formula values must start with =, or they will be output as text.

Set Byte Order Mark checked write a Unicode Byte Order Mark to the file (only available
for UTF encodings).

Check remove empty to recursively remove any nodes that have an empty value and no
children (only available for JSON and XML files). For example:

A AB ABC
1
2 1
3 1

Is output to XML with remove empty checked as:

<root>
<record>
<A>
<B>1</B>
</A>
</record>
<record>
<A>
<B>
<C>1</C>
</B>
</A>
</record>
</root>

Is output to XML with remove empty unchecked as:

<root>
<record>
<A>
<B>
<C></C>
</B>
</D>
</record>
<record>
<A>
<B value="1">
<C></C>
</B>
</A>
</record>
<record>
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<A>
<B>
<C>1</C>
</B>
</A>
</record>
</root>

Set Root name and Row name depending on the name you want to use for the root and
row XML records (only available for XML files).

Use Write mode to determine how existing files are treated:

Write mode for File exists with File exists without  File does not exist

Excel files named sheet named sheet

Overwrite / File Overwrite named Add named sheet, Create file with only
sheet, delete all delete all other named sheet
other sheets sheets

Overwrite / Sheet  Overwrite named Add named sheet Create file with only
sheet* named sheet

Append Append to named Add named sheet Create file with only
sheet named sheet

New Do nothing Do nothing Create file with only

named sheet

Disabled Do nothing Do nothing Do nothing

*Overwriting a named sheet can cause the file size to increase each time. You can delete the
file and re-output it if this becomes a problem.

Write mode for non-Excel  File exists File does not exist
files

Overwrite Overwrite file Create file
Append Append to file Create file

New Do nothing Create file
Disabled Do nothing Do nothing

Use Alias to identify the file for batch processing.
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Use Comment to record any notes that might be useful to a colleague or your future self.

2.5 File formats
2.5.1 File formats

Easy Data Transform supports the following data file formats:

Format Input Output
Delimited text (including Yes Yes
CSV and TSV)

Excel XLSX/XLS Yes Yes
Fixed width Yes No
JSON Yes Yes
HTML No Yes
Markdown No Yes
Plain text Yes No
vCard Yes Yes
XML Yes Yes
YAML No Yes

You can manage the default file type for different file extensions in the Input Extensions
and Output Extensions tabs of the Preferences window.

2.5.2 CSV format

Easy Data Transform can input from and output to CSV format files. Default file extension

.CSV'.

CSV (Comma Separated Value) format is commonly used for exchanging tabular data
between programs.

CSV is a type of delimited text file format. The column delimiter is usually a comma, but not
always. The row delimiter is line feed, carriage return or carriage return+line feed.

Easy Data Transform supports the following column delimiters:
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e Comma (,)

e Semi-colon (;)

e Colon ()

e Pipe ()

e Caret ()

e Tab (\t) (used for TSV format)
e Space ()

e Custom (choose your own)

For files padded to fixed column widths with space see Fixed width format.

To output to a CSV file you should typically set Delimiter to Comma (,) and Quoting to As
needed in the Right pane.

For example:
| CategorylD CategoryMame Description In stock
11 Beverages Soft drinks, coffees & teas true
1212 Condiments Sweet and savory sauces false
|
|
| 33 Confections Candies and sweet breads true

Is output with Delimiter set to Comma (,) and Quoting set to As needed as:

CategoryID, CategoryName, Description,In stock
1,Beverages, "Soft drinks, coffees & teas", true
2,Condiments, Sweet and savory sauces, false
3,Confections,Candies and sweet breads, true

Note that " quotes have been used to enclose values that contain delimiter characters.
Set Quoting to Always if you want to quote every value. Set Quoting to Never if you don't
want to quote values (delimiters and carriage returns within values will be changed to

spaces).

If you want to input a file with a different delimiter to those listed, then:
1. Input it with a delimiter unlikely to be in the text, e.g. caret (*), to input it as a single

column
2. Use the Split Col transform to transform it into multiple columns using the appropriate
delimiter.
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Many CSV file are not well formed. For example, they have unescaped quotes. As the CSV
format is not well-defined, badly formed CSV files can be interpreted in more than one way.
Easy Data Transform will do the best it can in these circumstances.

See also TSV format.

2.5.3 Excel format

Easy Data Transform can input from and output to Excel ".xIsx" and ".xIs" format files, even if
you don't have Excel installed.

Excel format is the native format of the Microsoft Excel spreadsheet application. It is
commonly used for exchanging tabular data.

You can specify the sheet name when inputting or output Excel files using square brackets,
€.0. MySpreadsheet.xlsx[Sheetl] means sheet sheet1 of file MySpreadsheet.xlsx.

You can specify how to format columns when outputting to Excel using the Formatting
option.

Please note the following limitations of Excel:

Excel .xlsx files are limited to 1,048,576 rows and 16,384 columns.

Excel xls files are limited to 65,536 rows and 256 columns.

Date values are input using ISO date format YYYY-MM-DD, regardless of your locale.
Datetime values are input using ISO date format YYYY-MM-DDTHH:MM:SS, regardless of
your locale.

¢ The following characters are not allowed in sheet names:\ / * [ 1 : 2

2.5.4 Fixed width format

Easy Data Transform can input from fixed width format files, also known as fixed column
width format. Default file extension ".txt".

Fixed width format is used for exchanging tabular data between programs. It is often
associated with legacy systems, but is also used for large files where performance is an issue
(e.g. bioinformatics).

In fixed width format each column has a fixed width in characters. There is no column

delimiter. Spaces are typically used as padding to make up the column width. The row
delimiter is line feed, carriage return or carriage return+line feed. For example:
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ID Name Payment Country Date
8904 John Black 12345.67 GB 08/20/2020
3999 Jane Brown 23456.78 US 08/20/2020
7489 Zadie Green 34567.89 DE 08/20/2020
Is input as:

i ID Name Payment Country Date

18904 John Black 12345.67 GB 08/20/2020

2 3999 Jane Brown 23456.78 U5 08/20/2020

'3 7489 Zadie Green 34567.89 DE 08/20/2020

Easy Data Transform will analyze the data and guess the column layout if you set Columns
in the right pane to Automatic. Or you can choose the column widths by setting Columns
to Manual. Click the "..." button to edit the manual column widths.
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fixed-example.txt @ d;’ EC
File: CA\Users\andy\Desktop\fixed-example.txt
L )
(Columns: Manual vl >
e i
€ Fixed Column Widths O X
Width Starts at Ends at
s
Column 2 |5 o7 11
F
Column 3 |8 v 12 19
Y
Column 4 10 - 20 29
Column 5 |9 T 38
FY
Column 6 {10 - |32 48
[
Merge | Split | Insert Left Insert Right Delete Columns: 6
Preview
DUDUDDG[}Dll].'lJ.lll1J.|2222222222333333333344444444-
123456/75901[23456789/0123456789012345678/901234567!
ID Name Payment Country [Date
8904 | John Black 12345.67 GB 0e/20/2021
3998 | Jane Brown 23456.78 [US 08/20/2021
7489 |Fadiel Green [(34567.89 [DE ne/20/20210
| |
OK Cancel = Help

The current column boundaries are shown on the first few rows in the Preview. The
horizontal offset of each character is shown in gray at the top. The currently selected
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columns are highlighted. Click on a column in the Preview to select it in the table, or vice
versa.

You can change the column widths using the Width column of the table.

Select 2 or more adjacent columns and click Merge to merge them into 1 column. Click
then Shift+click in either the table or the preview to select multiple adjacent columns.

Select 1 column with a Width > 1 and click Split to split into into 2 columns.

Select 1 or more adjacent columns and click Insert Left or Insert Right to add a new
column with width 1 to the left or right of the selected columns.

Select 1 or more adjacent columns and click Delete delete the selected columns.
Click OK to save your changes and Cancel to discard them.

Unwanted columns and rows in the dataset can be removed after input using the Remove
Cols and Filter transforms.

2.5.5 JSON format
Easy Data Transform can input from and output to JSON format files. Default file extension

"json".

JSON (JavaScript Object Notation) format is commonly used for exchanging data between
programs. JSON data is generally expected to be in UTF8 encoding without a Byte Order

Mark (BOM).
For example:
| CategorylD CategoryName Description In stock
11 Beverages Soft drinks, coffees & teas true
:2 2 Condiments Sweet and savory sauces false
i 33 Confections Candies and sweet breads true

Is equivalent to:

[

{
"CategoryID": 1,
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"CategoryName": "Beverages",
"Description": "Soft drinks, coffees & teas",
"In stock": true

"CategoryID": 2,

"CategoryName": "Condiments",
"Description”: "Sweet and savory sauces",
"In stock": false

"CategoryID": 3,

"CategoryName": "Confections",
"Description”: "Candies and sweet breads",
"In stock": true

The dot ('.") character is used in the column header to show nesting. For example:

name carb cholesterol fiber minerals.ca minerals.fe protein sodium vitamins.a vitamins.c

1 Avocado Dip 2 5 0 0 0 1 210 0 0

Is equivalent to:

"name": "Avocado Dip",
"carb": 2,
"cholesterol": 5,
"fiber": O,
"minerals": {
"ca": O,
"fe": O
b
"protein": 1,
"sodium": 210,
"vitamins": {
lla": O,
"C": O

Any dots in JSON names are converted to hyphens ('-') on input.

JSON arrays can be input in either long or wide Format. For example:

"name": lllll,

"Values": [ "a", "b" ]
s
{
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"name": "2",
"Values": [ llCll, lldll ]

Input as Long (more rows):

name values
11 a
21 b
32 C
|42 d

Input as Wide (more columns):

name values.0 values.1

11 a b

22 c d

An input JSON format file is expected to have either:

e asingle top-level array or object; or

¢ asingle JSON object on each line (see jsonlines.org).

e a record separator character followed by a single JSON object on each line (see REC7464).

You can specify the JSON type for each columns when outputting to JSON using the Value
types option. Any values that do not match the type selected are output as a JSON null
value.

2.5.6 HTML format

Easy Data Transform can output to tables in HTML format files. Default file extension
" html".

HTML (HyperText Markup Language) format is commonly used for creating web pages. If
you don't need the data to take up a whole page, you can just copy the <table> to

</table> part of the output.

For example:
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| CategorylD CategoryName Description In stock
11 Beverages Soft drinks, coffees & teas true
:2 2 Condiments Sweet and savory sauces false
i 33 Confections Candies and sweet breads true

Is output as:

<!DOCTYPE html>
<html>
<head>
<meta charset="UTF-8"/>
<title>C:\Users\andyb\Desktop\output.html</title>
<style>table,td,th{border:1px solid black;text-align:left;vertical-align:top;bord
</head>
<body>
<table>
<tbody>
<tr>
<th>CategoryID</th>
<th>CategoryName</th>
<th>Description</th>
<th>In stock</th>
</tr>
<tr>
<td>1</td>
<td>Beverages</td>
<td>Soft drinks, coffees &amp; teas</td>
<td>true</td>
</tr>
<tr>
<td>2</td>
<td>Condiments</td>
<td>Sweet and savory sauces</td>
<td>false</td>
</tr>
<tr>
<td>3</td>
<td>Confections</td>
<td>Candies and sweet breads</td>
<td>true</td>
</tr>
</tbody>
</table>
</body>
</html>

2.5.7 Markdown format

Easy Data Transform can output to tables in Markdown format files. Default file extension
Il‘mdll‘
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Markdown format is commonly used as a human-friendly markup language, which can be
automatically translated to HTML.

For example:

| CategorylD CategoryMNarme Description In stock

11 Beverages Soft drinks, coffees & teas true

122 Condiments Sweet and savory sauces false

|

I

| 33 Confections Candies and sweet breads true
Is output as:
| CategoryID | CategoryName | Description | In stock |
|[———— - [——— [-—— - [————————- |
| 1 | Beverages | Soft drinks, coffees & teas | true
| 2 | Condiments | Sweet and savory sauces | false
| 3 | Confections | Candies and sweet breads | true

You can also use Markdown when you need a plain text version of your data, for example in
a code comment.

Note that not all Markdown implementations support tables. If your implementation does
not support tables, you may need to output to HTML instead.

2.5.8 Plain text format

Easy Data Transform can input from plain text format files. Default file extension ".log".

Plain text format is used for outputting semi-structured data, such as computer generated
log files.

In plain text format the dataset is read into a single column. The row delimiter is line feed,
carriage return or carriage return+line feed.

For example:

03/22 08:51:01 INFO :..settcpimage: Associate with TCP/IP image name = TCPCS
03/22 08:51:02 INFO :..reg _process: registering process with the system
03/22 08:51:02 INFO :..reg process: attempt 0S/390 registration

03/22 08:51:02 INFO :..reg process: return from registration rc=0

Is input in plain text format as:
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1
1.03/22 08:51:01 INFO ..settcpimage: Associate with TCP/IP image name = TCPCS

2 03/22 08:51:02 INFO :.reg_process: registering process with the system
3 03/22 08:51:02 INFO :.reg_process: attempt OS/390 registration

4 03/22 08:51:02 INFO :..reg_process: return from registration rc=0

2.5.9 TSV format

Easy Data Transform can input from and output to TSV format files. Default file extension

sy,

TSV (Tab Separated Value) format is commonly used for exchanging tabular data between
programs.

TSV is a type of delimited text file format where values are separated by tab characters and
rows by line feed, carriage return or carriage return+line feed. Tabs and carriage return are
not allowed within data values, so there is no need for quoting or escaping delimiters, as
with CSV files. This means that TSV files are generally a bit more compact and faster to read
and write than CSV files.

To output to a TSV file you should set Delimiter to Tab (\t) and Quoting to Never in the
Right pane. If you have a tab character or carriage return within a value, then Easy Data
Transform will then convert it to a space on output.

For example:
| CategorylD CategoryName Description In stock
11 Beverages Soft drinks, coffees & teas true
122 Condiments Sweet and savory sauces false
|
|
| 33 Confections Candies and sweet breads true

Is output with Delimiter set to Tab (\t) and Quoting set to Never as:

CategoryID CategoryName Description In stock
1 Beverages Soft drinks, coffees & teas true
2 Condiments Sweet and savory sauces false
3 Confections Candies and sweet breads true
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2.5.10 vCard format

Easy Data Transform can input from and output to vCard format files. Default file extension
"vcf".

VCard format is commonly used as way of exchanging contact details between programs.

Note that you need to change the column header names to the values expected by vCard
(using the Rename Cols transform).

For example:
N FN ORG TELTYPE=WORKVOICE ADR;TYPE=WORK,PREF
1 Gump;Forrest;;Mr.; Forrest Gump Bubba Gump Shrimp Co. (111) 555-1212 100 Waters Edge;Baytown;

Is equivalent to:

BEGIN:VCARD

VERSION:3.0

N:Gump; Forrest;;Mr.;

FN:Forrest Gump

ORG:Bubba Gump Shrimp Co.

TEL; TYPE=WORK,VOICE: (111) 555-1212

ADR; TYPE=WORK, PREF:100 Waters Edge;Baytown;LA;30314;United States of America
END:VCARD

2.5.11 XML format

Easy Data Transform can input from and output to XML format files. Default file extension

xml'.

XML (Extensible Markup Language) format is commonly used for exchanging data between

programs.
For example:
| CategorylD CategoryName Description In stock
11 Beverages Soft drinks, coffees & teas true
:2 2 Condiments Sweet and savory sauces false
i 33 Confections Candies and sweet breads true

Is equivalent to:
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<?xml version="1.0" encoding="UTF-8"7?>
<root>
<record>
<CategoryID>1</CategoryID>
<CategoryName>Beverages</CategoryName>
<Description>Soft drinks, coffees &amp; teas</Description>
<In-stock>true</In-stock>
</record>
<record>
<CategoryID>2</CategoryID>
<CategoryName>Condiments</CategoryName>
<Description>Sweet and savory sauces</Description>
<In-stock>false</In-stock>
</record>
<record>
<CategoryID>3</CategoryID>
<CategoryName>Confections</CategoryName>
<Description>Candies and sweet breads</Description>
<In-stock>true</In-stock>
</record>
</root>

The dot ('.") character is used in the column header to show nesting. For example:

name carb cholesterol fiber minerals.ca minerals.fe protein sodium vitamins.a vitamins.c

1 Avocado Dip 2 5 0 0 0 1 210 0 0

Is equivalent to:

<?xml version="1.0" encoding="UTF-8"?>
<root>
<record>
<name>Avocado Dip</name>
<carb>2</carb>
<cholesterol>5</cholesterol>
<fiber>0</fiber>
<protein>1</protein>
<sodium>210</sodium>
<minerals>
<ca>0</ca>
<fe>0</fe>
</minerals>
<vitamins>
<a>0</a>
<c>0</c>
</vitamins>
</record>
</root>

Any dots in XML element names are converted to hyphens ('-') on input.
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The underscore ('_") character is used at the start of a column header name to identify it as
an XML attribute. For example:

_name _carb _cholesterol _fiber minerals.ca minerals.fe _protein _sodium vitamins.a vitamins.c

1 Avocado Dip 2 5 0 0 0 1 210 0 0

Is equivalent to:

<?xml version="1.0" encoding="UTF-8"?>
<root>
<record carb="2" cholesterol="5" fiber="0" name="Avocado Dip" protein="1" sodium="2
<minerals>
<ca>0</ca>
<fe>0</fe>
</minerals>
<vitamins>
<a>0</a>
<c>0</c>
</vitamins>
</record>
</root>

Repeated XML values can be input in either long or wide Format. For example:

<?xml version="1.0" encoding="UTF-8"?>
<ITEMS>
<ITEM>
<PARAM name="a" value="1"/>
<PARAM name="b" value="2"/>
</ITEM>
</ITEMS>

Input as Long (more rows):

PARAM. name PARAM. value
1b 2

2a 1

Input as Wide (more columns):

PARAM._ _value PARAM._name PARAM._value.l PARAM._name.l
11 a 2 b

You are responsible for ensuring that the names of XML nodes and attributes are valid (e.g.
start with a letter or underscore and do not contain spaces).
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2.5.12 YAML format

2.6

Easy Data Transform can output to YAML format files. Default file extension ".yaml".

YAML (YAML Ain't Markup Language) format is commonly used for exchanging data
between programs and for configuration files.

For example:
| CategorylD CategoryName Description In stock
11 Beverages Soft drinks, coffees & teas true
122 Condiments Sweet and savory sauces false
|
|
| 33 Confections Candies and sweet breads true
Is output as:

CategoryID: 1

CategoryName: Beverages

Description: Soft drinks, coffees & teas
In stock: true

CategoryID: 2

CategoryName: Condiments
Description: Sweet and savory sauces
In stock: false

CategoryID: 3

CategoryName: Confections
Description: Candies and sweet breads
In stock: true

Comments

You can manage the complexity of large .transform files adding comment text to:

e The Comment tab of Input, Transform or Output items. Check View>Show Comments
to show these comments in the center pane. The comment will be shown as a tooltip
when you hover over the item.
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- RA
Stats @ ':f. ']
(3 & Fiter colt
dateRep =
day
manth
year
W cases
] deaths
countriesAndTerritories =

Stats

Sum total cases.

1 of 11 columns selected

‘Calculation: Sum x

Transform
Name: Stats
Status: Up to date
Dataset columns: 11

Dataset rows: 14,659
Dataset values: 161,249

Connections in: 1 ﬁings Comment* | Re ¥
Cennections out: 0 " Sum total cases.

Transform type:  Analysis

\ Description: Calculate sum, min, max, average, median or standard deviation of

the selected column(s) by row and/for column. Results are shown in
@ new row at the bottom and/or column at the right.

On: Columns v

Calculate sum, min, max, average, median or
standard deviation of the selected column(s) by
row andfor column. Results are shown in a new
row at the bottom and/or column at the right.

Celumns: 1 column(s) (cases)
Calculation: Sum
On: Columns

Last processed:  Tuesday, January 26, 2021 2:23: T Standard Time
Processing time: 0,169 second(s)
Comment: Sum total cases.

~ L 4

n Form:

e The Comment field of Note items. These are added to the center pane by right clicking
and selecting Note from the menu. You can also set an Arrow direction and a Color. If
you right click on an existing item, the Note item will be placed pointing to that item, if
there is space. The comment will be shown as a tooltip when you hover over the Note
item.

Deaths by
date

Spread

o

Latest J'.i['_-_"'[”n','f[;_";;,?af-_- ,Remave Cols , Pivet ,  Sort , Count , Sort Death
COVID data R 2ewaia s e T frequencies

 Dedupe | S . ¥ Join | . PReplace b

) ( Mtl , Filter | ,/Num Format | JnuLpul.xstJ Deaths by

# i = 209 rewn & colax 185 mwn & ol x 155 i 3 155 o OOI.IntIT

& culn 3 208 s

Scale to per
10k
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! 6 ols % 155 rows

| output.xlsx
—nv Y )

Select items in the center pane
to view

¢ In the Notes window that is displayed when you select File>Notes... from the main
menu.

You can also group related items in the center pane to show that they are related.

2.7 Headers

If the first row of an input is a header (i.e. one that describes the columns below) check has
header for that input in the Right pane.
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vaccination.csv @ d‘: E;
File: ndy\Desktop\vaccination.csv ... |
Type: Delimited text v
Delimiter: Automatic v
Quoting: Automatic v
Encoding: Automatic v
Ignore:  First O row(s) .

v has header |
rim whitespace
v simplify whitespace i
v ignore empty rows
watch file
Meta info: Not added v
Alias: vaccination

Data = Warnings Info Conm 4|}

3 cols x 5,780 rows
C E% f © Show first 10 rows ¥

Guntry time bcg_vacD

When you first read in a dataset Easy Data Transform will make a guess about whether the
first row is a header (it will assume it is a header if it contains no dates or numbers).

You can move 1 or more dataset rows to the header using the Header transform.
2.8 Connections

When you select an input or transform item and add a transform or output item,
connections are added automatically.

To select a connection
To select a connection either:

Easy Data Transform © 2021 Oryx Digital Ltd



Reference

e Click on the connection; or
e Click and drag a box over any part of the connection. This may be easier than clicking the
connection when you are zoomed back.

transactions.x...

Y, Filter

35 cols x 53.3krows L} 35 cols x 53.3k rows

To delete a connection

To delete a connection:

e Select the connection.

e Select Edit>Delete (or click the Delete tool bar button).

Note that deleting a connection may unset column related parameters downstream, so

should generally be avoided where possible.

e If you want to change an input file, do it by selecting the input and clicking on "..." in the
Right pane, rather than disconnecting the input and connecting a new one.

e If you want to add a new transform between 2 already connected items, you can do it
without disconnecting (see below).

To add a transform to a connection

To add a transform between two already connected items:

e Select the connection.

e Choose the new transform from the Left pane or using the right click menu.

A"

/" CoVID-19-ge...

\/[COVID-19-ge... Dedupe
11 cols x 14.7k rows {14l wiE 5z 145k arse
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To add a connection
To add a new connection between two existing items:
e Hover over the start item.
e Click the '+' that appears.

Filter

transactions.x...

%)

lick to connect from this item.

35 cols x 53.3k rows

e Hover over the end item
e Click the '+' that appears.

Filter

transactions.x...

35 cols x 53.3krows lick to connect to this item.

Press the 'Esc' key or click away from an item to cancel adding the connection.

Note that the '+' will only appear if an additional connection is allowed. For example you
can't:

e Create a loop.

e Connect more than once from a transform.

e Connect more than once to an output.

2.9 Text

Whitespace (such as Space and Tab characters) and capitalization are always significant,
unless stated otherwise.

You can remove leading and trailing whitespace by checking trim whitespace in the Input
or using the Whitespace transform.

You can change the case using the Case transform.

You can concatenate and split columns of text using the Concat Cols and Split Col
transforms.
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2.10 Dates

Set Supported Date Formats in the Preferences window according to how you want to
interpret values as dates.

Format Meaning

d The day as number without a leading

zero (1to 31)

el The day as number with a leading zero
(01 to 31)

ddd The abbreviated localized day name (e.g.
‘Mon' to 'Sun’). Uses the system locale to
localize the name.

i The long localized day name (e.g.
'‘Monday' to 'Sunday'). Uses the system
locale to localize the name.

M The month as number without a leading
zero (1to 12).

MM The month as number with a leading zero
(01 to 12)

MM The abbreviated localized month name
(e.g. 'Jan' to 'Dec’). Uses the system locale
to localize the name.

Ll The long localized month name (e.g.
‘January' to 'December’). Uses the system
locale to localize the name.

vy The year as two digit number (00 to 99).

yyyy The year as four digit number. If the year
is negative, a minus sign is prepended in
addition.

For example:

e To support a date such as 31/1/2019 add a supported date format: d/M/yyyy
e To support a date such as 1-31-19 add a supported date format: M-d-yy

List the date formats in order of preference, with the most likely to be used first.
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Dates with only two year digits, are treated as a date between 1900 and 1999. E.g. "31/1/19"
is interpreted in d-M-yy format as 31st January 1919.

Values that are in a recognized date format will be treated as dates in transforms such as:
Calculate, Compare, Filter, If and Sort. Supporting large numbers of date formats will slow
down these transforms.

You can change the format of dates using the Date Format transform.

You can do date calculations, such as calculating the number of days between 2 dates, using
the Calculate or Javascript transform.

You can convert an ISO standard datetime (e.g. 2020-10-16T01:51) into separate date and
time columns by using the Split Cols transform on the "T" delimiter.

2.11 Numbers

Set the Locale in the Preferences window according to how you want to interpret values as
numbers. For example, if Locale is set to US or UK then "123.45" is a number and "123,45"
isn't, and vice versa if Locale is Germany or France.

An integer is a whole number. E.g. "1.0" or "1,0" (depending on your Locale), "0", "-1" and
"1e3" are considered integers.

You can change the format of numbers using the Num Format transform.

You can do numeric calculations, such as multiplying 2 columns, using the Calculate or
Javascript transform.

2.12 Meta Information

You can add meta information to input data using the Meta info field in the Right pane
when you select an input item. Set it to At start, At end or Every row, depending on where
you want the meta information to appear. Then click on the ... button to edit which
information you wish to show. The following placeholders are substituted by their actual
values at the time of input.

Meta Information Description Example
$ (ComputerName) The name of the MyComputer
computer.
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Meta Information Description Example

S (CurrentDate) The current date, in 2020-08-18
ISO format.

$ (CurrentDateTime) The current 2020-08-
datetime, in ISO 18T18:00:00
format.

S (DataColumns) The number of 10

columns in the
dataset (not
including meta
data).

% (DataRows) The number of row 10,000
in the dataset (not
including meta
data).

S (DataValues) The number of 100,000

columns x rows in
the dataset (not
including meta
data).

$(FileCreatedDate) The date the file 2020-08-18

was created, in ISO
format. Only
available for file
input.

S (FileCreatedDateTime) The datetime the 2020-08-

file was created, in LIwlgs e e

ISO format. Only
available for file
input.
S (FileName) The name of the myfile.csv
file, including it's
extension. Only

available for file
input.
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Meta Information

S (FilePath)

$(FileSizeBytes)

S (FileUpdatedDate)

$ (FileUpdatedDateTime)

S (UserName)

2.13 Column variables

Description

The full path

(location) of the file.

Only available for
file input.

The size of the file
in bytes. Only
available for file
input.

The date the file
was last updated, in
ISO format. Only
available for file
input.

The datetime the
file was last
updated, in ISO
format. Only
available for file
input.

The name of the
user (from the
USER or
USERNAME
environment
variable).

Example

Cs
\users\andy\Do
cuments\myfile
.Csv

1,234,567

2020-08-18

2020-08-
18T18:00:00

Andy

Some transforms allow you to use the values of columns on the same row using column
variables. Column values can be referenced either:

e By column header name, e.g. $ (item cost) for the 'item cost' column; or

e By column index, e.g. s (1) for the first column.

Notes:

e The column name is case sensitive.

¢ Whitespace at the start or end of the column name is ignored.
e If multiple columns have the same name, the first from the left will be used.
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e Reference by name takes priority over reference by index. For example, if there is a
column named "1" then $ (1) will refer to that rather than the first column.

2.14 Regular expressions
Easy Data Transform allows the use of regular expressions in the Filter, If, Replace, Slice and

Split Rows transforms. It is also available as part of the Javascript language in the Javascript
transform.

Regular expressions are a powerful way to match patterns in text (including text
representation of dates and numbers). For example, you can use a regular expression in the
Replace transform to swap first and last names:

Match type: Regex A

Replace: (w+Ns*(\w+)

With: \2,\1

Turns:
Full name

1 John Smith
2 Mary Brown

3 Jill Jones

Into:
Full name

1 Smith, John

2 Brown, Mary

3 Jones, Jill

Regular expressions are far too big a topic to cover here. However there are many detailed
resources online, such as www.reqular-expressions.info and regexr.com.
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2.15 Batch processing

To apply the current transform template file to multiple input files select File>Batch
Process... . The Batch Process window will appear with a column for each input item and a
column for each output item. The Alias for each item is displayed in the column header.

orders.csv
v

14 cols x 830 rows

Join output.json

:J v

24 cols x 830 rows 24 cols x 830 rows

customers. csv

11 cols x 91 rows

ey

|j—| Batch Proces

Input columns cpin include wildcards an Excel sheet names:

E.g. 'C\Users\anty\Documents\*.csv' or §:\Users\andy\Documents\data . xlsx[*]".
Output columnsican include: {customers), fgrders}, {date}, {time}, {datetime}:

E.g. 'C:\Users\anily\Documents\{customers] Ydatetime}.csv".

Click 'Help' for njore details.

Add Remofe | Clear

Input alias=customers Input alias=orders Output alias=output (Overwrite)
1\Users\andy\data\customers.csv ... |[C\Users\andy\data\*.csv ... \Users\andy\order_{orders}.json ...

wildcard input file name

Note:

e All input and output items must have an alias.

e An output item can't have the same alias as another output or input item.
e Output items with Write mode=Disabled are not shown.

Click Add to add a new processing row.

Click Remove to remove the selected processing row(s).

Click Clear to remove all processing rows.
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In the (pink) input column you can use * and ? wildcards for file name stems, file extensions
and Excel sheet names. E.g.:

Input Description
C:\Users\andy\Documents\*.csv All files with

extension .csv in the
Documents folder

C:\Users\andy\Documents\d?.csv All the files with

name 'd' plus a single
character in the
Documents folder

C:\Users\andy\Documents\data.xlsx[*] All the sheets in

data.xlsx in the
Documents folder

C:\Users\andy\Documents\*.x1lsx[data*] All the sheets
beginning with 'data’
in all the .xslx files in
the the Documents
folder

Note:

o If there is more than 1 input column that specifies multiple files or sheets, then an output
will be created for each possible permutation of input files/sheets in the row. E.g. 3 input
files from column 1 x 4 sheets from column 2 = 12 outputs to process.

e Excel sheet names are not case sensitive.

¢ You cannot use wildcards for folder names.

e Batch processing will ignore files in sub-folders.

e All the files input to an input item or output from an output item should be the same file
type as the original.

In the (green) output column you can use the following variables to create your output file

name:
Output variable Meaning Example
(dppue aliass) The name of the input  If input alias ‘orders' is

file being processed in using file 'C:
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the column with the \Users\andy\Documen

corresponding alias. ts\orders_2020.csv'
then ‘{orders}' is
replaced with value
'‘orders_2020".
If input alias 'orders" is
using file 'C:
\Users\andy\Documen
ts\orders_2020.xlIsx'
with sheet 'Sheet1'
then '{orders}' is
replaced with value
'‘orders_2020_Sheet1".

{date) Date processing was ~ 2020_04_18

carried out in
year_month_day
format

{time}

Time processing was 1521 56_599
carried out in

hours_minutes_second

s_milliseconds format

{datetime} Date/Time processing  2020_04_18_15_21_56_
was carried out in 599
year_month_day_hour
s_minutes_seconds_mil
liseconds format
format

Whether an ouput file is created, overwritten or appended to depends on the Write mode
of the output item.

Click Process to start processing the rows.
Click Stop to stop processing the rows.
Click Close to close the window.

See also:
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e Batch processing examples
e Command line arguments

2.16 Command line arguments

Easy Data Transform accepts the following command line arguments:

Argument Description

<file name> The .transform file to open at start-up.

—ekd Close the application once any processing on the opened
file is complete.

~file <alias>=<location> gets the input or output file with the given alias to the
location (path) specified. Input Excel files should include
the sheet name, e.g. file.xlsx[sheet]. Output Excel files
may optionally include a sheet name. The file type should

be the same as the original.

s rnelo Don't load the last opened .template file, even if open

previous file at start-up is checked in Preferences.

~verbose Output additional information to the terminal.

This allows you to process .transform files in batch mode. For example:

Torun C:\Users\andy\Documents\myfile 1.transform with the output with alias output1 output ins

"C:\Program Files (x86)\EasyDataTransform vl\EasyDataTransform.exe" "C:\Users\andy\Do

Torun Cc:\Users\andy\Documents\myfile2.transform with the input with alias input1 input instead -

"C:\Program Files (x86)\EasyDataTransform vl\EasyDataTransform.exe" C:\Users\andy\Doc?
Put quotes (") around any arguments with spaces (as shown in the examples above).

To do this on a schedule, call a .bat file from a scheduling program, such as Windows Task
Scheduler.

See also:
e Batch processing
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2.17 .transform files

.transforms file are stored in a simple XML format. So you can edit them with a standard text
editor. However we recommend you make a copy first.

The results of transformations are not stored in the .transform file, and are recalculated
whenever you File>Open... the file.

The contents of Input and Output files are not stored in the .transform file, only their
locations. These locations are stored as 'absolute’ locations, so you can move the .transform
file without changing the locations of the Input and Output files.

If you open a .transform file in a different location from that in which it was saved and it
can't find Input and Output files at the expected location it will look for them in the same
location relative to the old .transform file. This allows you to easily move .transform files to
different locations and computers if you keep the Input and Output files in the same relative
location (e.g. in the same folder as the .transform file). This even works between Windows
and Mac (and vice versa),

Example:

® mytransform.transformisin C:\Users\andy\Documents\ on Windows and uses Input
file MyData.csv in sub-folder Mybata (C:\Users\andy\Documents\Data\MyData.csv).

e mytransform.transform is moved to /Users/Bob/Documents/EDT on a Mac.

e When mytransform.transform is opened it will look for MyData.csv
in /Users/andy/Documents/Data.

¢ If it can't find that it will look for MyData.csv in sub-folder Mypata
(/Users/Bob/Documents/EDT/Data/MyData.csv).

If you paste in data From Clipboard this is stored in the .transform file. We don't
recommend you do this for large datasets as XML is not very efficient for storing large
amounts of data.

2.18 Keyboard shortcuts

Using keyboard shortcuts can improve your productivity. If you are using Easy Data
Transform a lot we suggest you find the time to learn at least some of them. The following
keyboard shortcuts are available for the Windows version of Easy Data Transform:

Key Shortcut Action
A Ctrl+a Select all in Center

pane.
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Key Shortcut Action

B Ctrl+B Show the Batch
Process window.

D Ctrl+D Duplicate the selected
branch in the Center
pane.

BMLERL Input From File.
ALt+Shift+l Input From Clipboard.
N CEr Ly New .transform file.
0 Ctrl+o Open .transform file.
Ctrl+Shift+0 Show the Open
Recent window.
ALT+0 Output To File.

S CEELie Save .transform file.

T Ctrl+T Toggle two screen
mode on/off

U Gzl Toggle user interface
between light and
dark themes (if
available).

% Ctrl+Y Redo

7 Ctrl+z Undo

Del Del Delete selected
item(s) in Center
pane.

. Cerlt, Show Preferences
window.

= Ctrl+= Zoom Center pane so
all items fit.

+ Gleedae: Zoom Center pane in.
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Key

Left arrow

Right arrow

Up arrow

Down arrow

1.9

F1

F11

Shortcut

Ctrl+-

Ctrl+Left arrow

Alt+Left arrow

Ctrl+Right arrow

Alt+Right arrow

Ctrl+Up arrow

Ctrl+Down arrow

Ctrl+l...Ctrl+9

Alt+1...A1t+9

Fl

F11

Action

Zoom Center pane
out.

Move Center pane
selection from item to
highest[1] item that
inputs to it.

Move keyboard focus
to Center pane.

Move Center pane
selection from item to
highest[1] item that it
outputs to.

Move keyboard focus
to Right pane.

Move Center pane
selection from item to
highest[1] sibling[3].

Move Center pane
selection from item to
lowest[2] sibling[3].

Select input item 1 to
9 (based on height in
Center pane).

Select output item 1
to 9 (based on height
in Center pane).

Show help.

Toggle setting Right
pane item to
fullscreen. Only works
if 1 item in Right
pane.

[1] Highest=nearest the top of the Center pane.
[2] Lowest=nearest the bottom of the Center pane.
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[3] Two items are considered siblings if they have inputs from the same item(s) or they both
have no inputs.

You can also use the keyboard to add transforms in the Center pane. Just select the item(s)
you want to add the transform to and start typing the name. Only eligible transform that
contain the typed letters will be displayed (spaces are ignored).

For example, to add the Rename Cols transform an existing Input item:

e select the input items

e type ren

e press the Return key

If you want to see a list of all the transform names, press the space key before you start
typing. You can use the Del or Backspace key to undo letters typed.

You can quickly change selection in the Center pane using arrow keys with the ctr1 key.

Left Arrow Up Arrow

Dedupe

JRemove Cols

4

4 ols x 14.7k rows 4 ls x 209 rows

Right Arrow

Pivot L/ Sort

2 ols x 210 rows 2 ls x 210 rows

Spread

v

104 cols x 209 rows

| Down Arrow |

If you are zoomed in you can scroll the Center pane by pressing the shift key and
dragging the canvas.
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2.19 Dark mode

Select View>Toggle Ul Theme to swap between light and dark user interface themes. You
can also change the Center color scheme in the Colors tab of the Preferences window.

& Easy Data Transform v1.15.0 (licensed to Oryx Digital Ltd)* - 0o x

Date Format

ElEmail us quest
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3 How do I?

3.1 Add atransform between existing items

To add a new transform between existing items (e.g. between 2 already connected
transforms) see connections.

3.2 Add or remove a header

To add or remove a header just check or uncheck the has header checkbox for the
appropriate input item.

vaccination.csv @ Q{: ES
File: ndy\Desktop\vaccination.csv ... |
Type: Delimited text v
Delimiter: Automatic v
Quoting: Automatic v
Encoding: Automatic v
Ignore:  First O row(s) =
v has header |
nm whitespace
v simplify whitespace i
v ignore empty rows
watch file
Meta info: Not added v
Alias: vaccination

Data = Warnings Info Comr < |}

3 cols x 5,780 rows
C Eg'@ f & Show first 10 rows ~

G:mntf].»r time bcg_vacD
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You can also make the first row of your dataset into a header using the Header transform.
3.3 Change a connection

To change a connection see connections.
3.4 Change encoding

When Easy Data Transform inputs a text file (e.g. a CSV file) it will make a guess at the
encoding. You can explicitly set the encoding by selecting an input item and changing
Encoding from Automatic to one of the other encodings in the Right pane.

vaccination.csv ® E ;
File: ndy\Desktop\vaccination.csv
Type: Delimited text v
Delimiter: Automatic b4
Quoting: Automatic v
Encodin v
Ignore:  First O row(s) .

Similarly you can also set the encoding of a text file output by selecting the output item and
changing Encoding in the Right pane.

output.csv ® E i
File: \andy\Desktop\output.csv ...
Type: Delimited text v
Delimiter: Comma (,) 5
Quoting: As needed v
Line endings: Automatic v
Encoding: v
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3.5 Duplicate a series of transforms

To duplicate multiple items in the center pane (e.g. a sequence of transforms) right click on
the first item and select Duplicate Branch.

solar.xlsx -
<  [data] L, Javascript » ,Interpolate
6 colks x 2.8k rows ‘ 7 coks x 2.8k rows 8 (U:::p;:::aws
v “’eﬁ'}ﬁg;"“ _I Filter I , Javascript
23 cols x 25.4k rows | 23cols| NP ’
\—J Transform »
Qutput »
Duplicate Branch Ctrl+D
Connect..
Disconnect
Disconnect Upstream
Disconnect Downstream
® Delete Del
solar.xlsx .
s [data] , Javascript » ,Interpolate

i peter Stur &

6 cols x 2.8k rows 8 cols x 2.8k rows

7 cols x 2.8k rows

weather.xlsx
e [data]

23 coks x 25.4k rows

v Filter . v

23 cols x 8.5k rows

script

24 cols x 8.

Interpolate

B petsr atur &
8 cols x 2 8Bk rows

Filter

23 cols x 8.5k rows

Javascript

24 cols x 8.5K rows

3.6 Dedupe adataset

If you want to remove duplicate entries from a dataset, use the Unique transform. For
example, to remove the 2 rows that have the same email from this dataset:
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i First Last Email

|1J.A. Black jablack@gmail.com

' 2 Paul White p.white@hotmail.com

3 Barry Green bgreeni@aocl.com

4 Jane Brown Jb3423@gmail.com

5J).  Taupe taupe89759@gmail.com

16 John Black jablack@gmail.com

7B.  Green bgreen@acl.com

To get this dataset:

First Last Ermail

1J)A Black jablack@gmail.com

2 Paul White p.white@hotmail.com
3 Barry Green bgreen@aol.com

4 Jane Brown Jb3423@gmail.com

51 Taupe taupe89759@gmail.com

Drag the dataset file onto the Center pane of Easy Data Transform.

mailing.xlsx
[Sheetl]

3 cols x 7 rows

Select the dataset then click the Unique transform in the Left pane.
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mailing.xlsx
o/  [Sheetl]

3 cols x 7 rows

Unique

3 cols x5 rows

Set the Email column to Keep unique in the Right pane. Set the First and Last columns to

Keep first.
Unique @& o3
Column Option
First Keep first v
Last Keep first v
Email Keep unique hs

Keep unique for 1 of 3 columns
Concat delimiter: |,

add count column

Only one row with each email is kept. The first and last names are set to the first occurrence
in the sort order. Use Sort if you want to change the order before removing duplicates.

If you only want to remove rows with the same first name, same last name and same email,
set First, Last and Email columns to Keep unique.

Note that de-duplicating columns takes account of whitespace and case. So you might need
to do Whitespace and Case transforms before the dedupe.

See the Unigue documentation for a more detailed example.
3.7 Find the difference between dates/datetimes

You can calculate the number off days difference between two dates using the Calculate
transform. For example:
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Start End
131/12/2019 7/1/2020

2 01/01/2021 15/1/2021

3 07/01/2021 8/1/2021

}

Calculate @ Qu @ EQ
Column 1: End v )
Operation: - Subtract v
Column 2: Start v

Start End End-Start

131/12/2019 7/1/2020 7
2 01/01/2021 15/1/2021 14

3 07/01/2021 8/1/2021 1

You can convert a datetime into a date using a transform such as Extract.

Alternatively, you can calculate the difference between two dates or datetimes using Date
objects in the Javascript transform.

There are 4 ways to create a Javascript Date object:
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Date format Description

new Date(year, month, day, hours, Specified date and time specified as
minutes, seconds, milliseconds) . .
numeric parameters (January is month 0!).

new Date (text date) Date and time specified as text.
new Date(milliseconds) Milliseconds after 1st January 1970.
new Date () Current date and time.

Notes:

e A text date should be in yyyy-mm-dd format.

¢ A Date object always includes a time. If no time is set, then the time is assumed to be
midnight GMT.

¢ One and two digit years will be interpreted from 1900.

Examples

To calculate the number of milliseconds between a date in the 'date' column and 31st Dec

2000:

return new Date( $(date) ) - new Date( "2000-12-31" );
Or:

return new Date( $(date) ) - new Date( 2000, 11, 31 );

To calculate the difference between datetimes in the 'start' and 'end' columns in hours:
return ( new Date( $(end) ) - new Date( S$(start) ) ) / ( 60 * 60 * 1000 );
To calculate how many days ago 'date' occurred (rounded down):

return Math.floor( ( new Date() - new Date( $(date) ) ) / ( 24 * 60 * 60 * 1000 ) );:

For more information see the Javascript documentation.

3.8 Handle column name/order changes in inputs

If you have a .transform file that you want to run multiple input files through (perhaps with
a different input file each month, or as a batch process) you need to be aware of differences
in column name and column order in the input files.
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To change the file being used by an input, select the input item and change the file location
in the Right pane (e,g, by clicking the "..." browse file button), rather the disconnecting the
input and connecting a new one. Otherwise column-related parameters downstream will be
reset.

Same columns in the same order, but with different names

Easy Data Transform references columns by their position (e.g. 3rd column from the left) not
their column name. So differences in column names (e.qg. first column is called "id" in input 1
and "UniquelD" in input 2) are not generally an issue. But you need to be careful if you are
using the Stack transform with Align columns by set to Header name, as this will reorder
columns by name. If you want to always output the same column names, regardless of the
input column names, you should use a Rename Cols transform to set the names.

Same columns with the same names, but in a different order

If columns are in different orders in different input files (e.g. the "id" column in the first
column in input 1 and the second column in input 2) you need to sort the input columns
into a standard order before applying other transforms. You can so this using the Stack
transform with Align columns by set to Header name. Stack your input under a dataset
with columns in the correct order. You can use a Filter to remove any unneeded rows after
the stacking.
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ID title first last

1 dummy

o
F N

. header-order.c...

4 cols x 1 row

.'I . t.
J INpUt.csv

-

4 cols x 2 rows

title first last ID

1Mr  John Smith 001

2 Ms Jane Smith 002

Stack _ @2

Align columns by !

Comment:

Stack rows of all inputs. Orders by the
vertical (Y) position of the input

4 cols x 3 rows i

RB 7
ID title first last
1 dummy
2 001 Mr  John Smith
3 002 Ms  Jane Smith

Stack

4 cols x 3 rows

Filter

v v

4 cols x 2 rows

Ro):

Matching any -

Filter

@ ® keep ~

mn Op Value |
1D Yi|l=v dumnD

4 ¥

Comment:

Filter rows by text, date or numeric
values in selected columns.

4 cols x 2 rows

&<

ID title first last
1001 Mr John Smith
2002 Ms Jane Smith

Same columns with different names, in a different order
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Easy Data Transform can't handle this automatically. But you can create a new .transform
and use Reorder Cols and/or Rename Cols transforms to output to a new file with the
correct column names/ordering. You can then input this to the original .transform.

3.9 Handle large datasets

Large datasets (e.g. a million data points or more) can slow down processing. If slow

processing is a problem you can:

e Add a sample transform straight after the input and set Rows to pass through only the
first 100 or so rows. Once you have completed all your transforms you can then Disable
sampling to pass through all rows.

¢ Set Right pane processing delay in the Preferences window to a longer time (say 5
seconds) to ensure that that changes aren't processed until you have finished making the
changes.

¢ Set Write mode to Disabled in output files, until you are ready to write them.

3.10 Input a fixed width format file

To input data from a fixed width file see fixed width format.

3.11 Merge datasets

Easy Data Transform has two main options for merging two datasets. Stack and Join.

Stack datasets

If you want to merge the two datasets so they are one on top of another, use the Stack
transform. For example, to Stack these two datasets:

MName ID DOB

John Black 001 01/07/1966
Paul White 002 11/03/1973

Barry Green 003 30/12/1977,

+
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i Name ID DOB

Jane Brown 004 03/11/198

! Jill Taupe 005 01/03/198

To get this dataset:

Name ID DOB
1 Q‘I_I'I Black 001 1966-07-01

2|Paul White 002 1973-03-11

3 @r}f Green 003 19??-12-_5"[}/

4 fane Brown 004 1980-11-02\

Slil\lTaupe 005 1981—(]3-[5}

Drag the two dataset files onto the Center pane of Easy Data Transform.

datasetl.xlsx|...

3 aolsx Irows

dataset2.xIsx]...
v

3 cols x 2 rows

Select the two datasets using ctr1+click then click the Stack transform in the Left pane.
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datasetl.xlsx|...

3 wlsx Irows

Stack

3 olsx Srows

v

dataset2.xlsx[...

3 cols x 2 rows

The datasets are now stacked in the vertical order that the datasets are shown on the
screen. The top dataset is shown first. You can swap the the vertical positions of the
datasets to change the order in which they are stacked.

If you want to stack column n of the first dataset above column n of the second dataset, set
Align columns by to Column number.

If you want to stack columns by common header names (even if they aren't in the same
order), set Align columns by to Header name.

If you want to stack a large number of files you can do it by using batch processing to write
to an output item with Write Mode=Append.

Join datasets

If you want to merge the two datasets side-by-side using a common (‘key') column, use the
Join transform. For example, to Join these two datasets:

MName D DO

B ID  Department Level
lﬁn Black 001 1965*3?&

651 Engineering 1—\

=

2 Paul White 002 1973-03-11 2|003 Engineering 2
3 Barry Green @03 1977-12-30 I 3|004 Marketing 1
4 Jane Brown 004 1980-11-03 41002 Sales 2

1]

IS@TEUPE 005 1981{!3—31 QS Sales 3_/
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By common ID value to get this dataset:

Mame ID DOB Department Level

1 dg’h_n Black I(l.'.ll.'.il 1966-07-0 Engineering 1 )
2 |Paul White | 002 [1973-03-11 Sales 2
3|Barry Green| 003 1977-12-3( Engineering 2

4lane Brown| 004 [1980-11-04 Marketing 1

wTaupe @31981—{]3—{};1 Sales 3

Drag the two dataset files onto the Center pane of Easy Data Transform.

(%]

datasetl.xlsx|...

3 alsx Irows

dataset2.xIsx]...
v

3 cols x 2 rows

Select the two datasets using ctr1+click then click the Join transform in the Left pane.
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datasetl.xlsx]...
v

Jcols x5 rows

b/ Join

5 cols x5 rows

dataset2.xlsx|...

3 cols x5 rows

Set both Top key column and Bottom key column to the common (‘key') column.

The datasets are now joined side-by-side using the common column. The top dataset is
shown on the left. You can swap the the vertical positions of the datasets to change the
order in which they are joined.

If you just want to join row N of one dataset to row N of another dataset, you can use the
Row Num transform to create a common column in each dataset.

Set include top non-matching rows and include bottom non-matching rows depending
on what you want to do with top and bottom dataset rows for which there are no matches.

Note that matching columns takes account of whitespace and case. So you might need to
do Whitespace and Case transforms before the join.

If you are merging numerical datasets you can also use an Interpolate transform.

Video: How to join Excel files

3.12 Move a .transform file

To move a .transform file to a different location on the same computer use File>Save As...
or Windows Explorer. You either leave the Input files at the original location or move them
to the same location relative to the .transform file (e.g. if they were in the same folder as the
.transform file before, move them to the same folder as new .transform file).

To move a .transform file to a different computer, move the Input files to the same location

relative to the .transform file (e.g. if they were in the same folder as the .transform file
before, move them to the same folder as new .transform file).
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3.13

See also .transform files.

Output nested JSON or XML

You can use the dot ('.") character in the column header to show nesting. For example:

name carb cholesterol fiber minerals.ca minerals.fe protein sodium vitamins.a vitamins.c

1 Avocado Dip 2 5 0 0 0 1 210 0 0

Is output to JSON as:
[

"name": "Avocado Dip",
"carb": "2",
"cholesterol": "5",
"fiber": "0",
"minerals": {

"Ca": HOH,

"fe": "O"
b
"protein": "1",
"sodium": "210",
"vitamins": {

"a": "O",

e MOV

And to XML as:

<?xml version="1.0" encoding="UTF-8"?>
<root>
<record>
<name>Avocado Dip</name>
<carb>2</carb>
<cholesterol>5</cholesterol>
<fiber>0</fiber>
<protein>1</protein>
<sodium>210</sodium>
<minerals>
<ca>0</ca>
<fe>0</fe>
</minerals>
<vitamins>
<a>0</a>
<c>0</c>
</vitamins>
</record>
</root>

For more details see:

e JSON format
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3.14

e XML format

Output to Excel

To output results from a transform to an Excel .xIsx/.xls file:
e Select the transform item in the Center pane.
e Click To File at the bottom of the Left pane.

& Easy Data Transform v1,15.0 (licensed to Oryx Digital Ltd)* - O x
Eile Edit View Licensing Help
DEBE v ARG @  rHowDol?

6 afg 1987 27

vaccination2.csv
7 afg 1988 40

Rename Cols (@ Stack (O] 2l
Reorder Cols (2 Align calumns by: Header name v
s R e
Row Num (& datasets
sample (@ Data  Warnings  Info  Comm < *
Slice @ 3 cols x 10,258 raws
Sort @ 3B & @ showfistiOrows ~
Split Col @) ULl e T country time beg_vace
Split Rews (@) 3 eols x 5.8k rows 1 afg 1982 10
spread (@ 2 afg 1983 10
Stack @ Stack 3 alg 1384 11
7
S;::: g JSmllxm-Sch 4 afg 1985 17
5 afg 1986 18
Substitute (&
@
@
@
@
@
@
@

Summa
s b 3 mls x 4.5k rows
Tatal g afg 1389 28
Transpose 9 afg 1990 20
Unigque
qu 10 afg 1991 21
Units
Whitespace Last 10,248 rows not shown
' QOutput

< To File }2),

EEmail us questions/feedback

e Select *.xlsx or *.xls from the file type drop-down list that appears.

File name: | output.csv

Save as type: |CSV file (*.csv)
CSV file (*.csv)

Excel file{*.xls)

~ Falda-e

Easy Data Transform © 2021 Oryx Digital Ltd




How do I?

Note that Excel .xIsx files are typically limited to 1,048,576 rows and 16,384 columns.

See also:
e Write to multiple sheets of an Excel file

3.15 Perform the same transforms on many files

You can perform the same set of transforms on multiple inputs in one operation using batch
processing or command line arguments.

Example 1
To convert a folder full of .csv files to .json files:

1. Select File>New to create a new transform template file

2. Drag one of the .csv files onto the Center pane. Ensure the options (encoding etc) are
correct in the Right pane.

3. Click on the To File button at the bottom of the Left pane and set the location of a .json
file to create. Ensure the options (encoding etc) are correct in the Right pane.

testl.csv

Y output.json

v

22 cols x 64 rows 22 cols x 64 rows

4. Select File>Batch Process.
5. In the Batch Process window change the .csv file name to *.csv and output.json to
output {testl}.json.
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@ Batch Process* X

Input columns can include wildcards and Excel sheet names:

E.g. 'C:\Users\andy\Documents\*.csv' or 'C:\Users\andy\Documents\data.xIsx[*]".
Output columns can include: {test1}, {date}, {time}, {datetime}:

E.g. 'C:\Users\andy\Documents\{test1}_{datetime}.csv".

Click 'Help' for more details.

Add Remove  Clear

Input alias=test1 Output alias=output (Overwrite)
1 C:\Users\andy\Desktop\*lcsv ... |C\Users\andy\Desktop\output_{test1},json

Process| Stop

6. Press the Process button. A .json file will now be created for each .csv file in the folder.

If you want to process input files from another folder then click Add to add a new row and
change the test1 input folder.

Example 2
Merge multiple .csv files into a single .csv file:

7. Select File>New to create a new transform template file

8. Drag one of the .csv files onto the Center pane. Ensure the options (encoding etc) are
correct in the Right pane.

9. Click on the To File button at the bottom of the Left pane and set the location of a
merged.csv file to create, in a different folder to the input .csv files. Ensure the options
(encoding etc) are correct.

testl.csv merged.csv

v v

22 cols x 64 rows 22 cols x 64 rows

4. Set Write Mode to Append in the Right pane.

Easy Data Transform © 2021 Oryx Digital Ltd



How do I?

merged.csv ‘@ EZ.
File: C\Users\andy\Desktop\merged\merged.csv II’
Delimiter:  Comma (,) v l
Encoding: UTF-8 v |

Values as: Nodes

v Byte Order Mark

Write mod v i

Alias: merged I

5. Select File>Batch Process.
6. In the Batch Process window change the input .csv file name to *.csv.

D——“ Batch Process X

Input columns can include wildcards and Excel sheet names:

E.g. 'C:\Users\andy\Documents\*.csv' or 'C:\Users\andy\Documents\data.xlsx[*]'.
Output columns can include: {test1}, {date}, {time}, {datetime}:

E.g. 'C:\Users\andy\Documents\{test1}_{datetime}.csv'.

Click 'Help' for more details.

Add Remove | Clear

Input alias=test1 Output alias=merged (Append)
1/C\Users\andy\Desktop\*.csv ... C\Users\andy\Desktop\merged\merged.csv

Process| Stop

7. Press the Process button. A single merged. csv file will now be created that contains a

concatenation of all the other .csv files. If merged.csv already exists, you may need to
delete it first.
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If the headers are different orders in different .csv files, then you can Stack by header name
to get a consistent column order before outputting.

colum n-order. ...

S cols x 1 row

Stack

27 cols x 65 rows

merged.csv
v g
27 @iy x65 row s

testl.csv

22 cobs x G4 rows

]
Stack 23 :

I
Align columns by Eeader name ) =
Comment:

3.16 Replace empty values

You can replace empty values using the Replace transform.
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ni n2 n3
1123.8 9789.1

2981234 233
3288
Replace Qledl= EC!
E Q Filter columns l
v n1 |
Vv n2 :
v n3

3 of 3 columns selected

CNRAS

|
Match Type Replace With f
|

1 Empty v ‘ 0.0
ni nZ n3

11238 9789.1 0.0
2981234 0.0 23.3

3288 0.0 0.0

3.17 Show whitespace

Click the eye icon in the Right pane to show whitespace in the data.
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Data Warnings Info Comment Results

3 cols x 3 rows

Sy

A B

Press to show whitespace in the dataset as symbols:
11 <121 Space:

- : Tab: -
2 Carriage return:  «
3 .47~ -8 |Line feed: o

Other whitespace: o

3.18 Write to multiple sheets of an Excel file

To write to multiple sheets (tabs) of the same Excel file you need to set the Write mode of
each output item to Overwrite/Sheet (to clear the sheet first) or Append (to add to
existing sheet data).
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RA
customer.xlsx[records] ‘@ d} ¢N

File: »p\customer.xlsx[records] ...

Format as: Number/Bool/Date/Text ~

@e mode: Overwrite ¥ Shee’c) ~

| customers.csv

e

[ customer.xlsx

4*/ [records]

11 cols x 91 rows

N\

11 cols x 91 rows

Sy

customer.xlsx
/ [summary]

Y Summary

12 cols x 9 rows

12 cols x 9 rows

KA
customer.xIsx[summary] l ® YN

File: \customer.xlsx[summary] ...
Format as: Number/Bool/Date/Text ¥
p@e mode: Overwrite ¥ Sheet v

If you set the Write mode to Overwrite/File for an item then the write will remove existing
sheets.
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Expert tips
4.1 Expert tips

Here are some tips to help you be more productive with Easy Data Transform.

1. To add a transform click an existing Center pane item and type the first few letters of the
transform name.

/ COVID-19-geo...
v [COVID-19-ge...

11 cols x :{,\\}.?k rows

2. Hold down the shift key and drag on the Center pane to scroll left/right/up/down.
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Y Dedupe

{rows 18 cols x 830 rows

Press S

v

\\\
\\\h_

tax-rates.csv

11 cols x 70 rows

3. Use Note items to remind yourself how a complex . transform works.
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! 6 ols % 155 rows

| output.xlsx
—nv Y )

Select items in the center pane
to view

4. To select multiple items in the Center pane, left click with the mouse and drag a box over
the items you want to select.

5. Try to avoid disconnecting transforms, as this can reset column related options
downstream. Add a transform to an existing connection instead.

6. Add a Sample transform straight after the input of a large dataset and set Rows to pass
through only the first 100 or so rows. Once you have completed all your transforms you can
then Disable sampling to pass through all rows.

7. Click the eye icon in the Right pane to show whitespace in the data.
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Data Warnings Info Comment Results

3 cols x 3 rows

Sy

A B

Press to show whitespace in the dataset as symbols:
11 <121 Space:

Tab: -

24 2 Carriage return:  «
3 .47~ -8 |Line feed: o

Other whitespace: o

8. If you need several similar branches of transforms you can create one branch and
duplicate it.

9. If you have 2 or more monitors connected to your computer try View>Two Screen
Mode to show the Right pane on your second monitor.

10. Use batch processing with wildcards (e.g. *.csv) to process multiple data files in one
operation.

11. Use command line arguments to run . transform files from a batch file.

12. Learn keyboard shortcuts. For example, you can quickly change selection in the Center
pane using arrow keys with the ctr1 key.
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[ Left Arrow ] [ Up Arrow ]

y V

L/ Remove Cols Dedupe

/

4 cols x 14.7k rows 4 ls x 209 rows

Right Arrow

v

Pivot v Sort

2 ols x 210 rows 2 als x 210 rows

Spread

/

104 cols x 209 rows

[ Down Arrow ]

13. Change the Center pane color scheme in the Colors tab of the Preferences window.

14. Select View>Toggle Ul Theme to swap between light and dark user interface themes.

&€ Easy Data Transform +1.15.0 (licensed to Oryx Digital Ltd)* - o %
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Support

Forum

There is a discussion forum online at forum.easydatatransform.com. You can use this to ask
questions, share what you are doing and keep up to date with news.

Contact support

If you have any questions or suggestions, please post a question on
forum.easydatatransform.com or email us at support@easydatatransform.com.

Report a bug

Please report any bugs you find to support@easydatatransform.com Please include:

e your operating system (e.g. Windows 10)

e the version of Easy Data Transform (from Help>About)

e a step-by-step description of how we can reproduce the problem
e your .transform file and input data files (where appropriate)

e a screen capture or video can often be helpful

The step-by-step description is particularly important - if we can't reproduce your problem,
then we probably won't be able to fix it.

We treat all data sent to us as confidential, unless you tell us otherwise. If your data is
particularly sensitive, it might be enough to send us just the first few rows with sensitive
values changed. Keep the same column structure though.

Request an enhancement

We are always very interested to hear your suggestions on how the software can be
improved. Please post a feature suggestion on our forum.easydatatransform.com or email
us at support@easydatatransform.com.
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command line arguments 136
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copy 145

copycols 37
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cross 38

crosstab 84

CSV format 108
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dark mode 141

date format 39

dates 128

day of week/month/year 27
decode 41

dedupe 42

divide 27

duplicate 145
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Excel format 110
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extensions 23
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file formats 108
fill 43

filter 44
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forum 174
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-H-

header 47,124

HTML 115

110
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input 24
insert 50
interpolate

5
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113
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remove cols 68

- L - rename cols 69
reorder cols 70
Left pane 21 replace 71
logarithm 27 Right pane 22
long pivot 46 rownum 75
lookup 62 S
B M - sample 75
Main window 21 scheduling 136
Markdown format 116 scripting 56
meta information 129 slice 76
month 27 sort 79
multiply 27 split col 80
splitrows 82
spread 84
= N = stack 85
stamp 87
new col 65 standard deviation 89
num format 66 stats 89
numbers 129 substitute 90

subtract 27,92

- O - summary 92

system requirements 7

-T-

output 103

-P-

text 127
pad 67 total 95
paste 145 transpose 97
pivot 67 trim 98
pivot longer 46 TSV format 118
pivot wider 84
Plain text format 117 - U -
power 27
preferences 22 unique 98
Preferences window 22 units 100
unpivot 46
- Q - URL encode/decode 41
Quick start guide 7 - V -
- R - vCard format 119

vcf format 119

regular expressions 132
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whitespace 102, 163
wide pivot 84

-X -

XML escape/unescape 41
XML format 119

Y-

YAML format 122
year 27
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